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RISK OF ELECTRIC SHOCK
DO NOT OPEN

CAUTION

CAUTION: TO REDUCE THE RISK OF ELECTRIC SHOCK,

DO NOT REMOVE COVER (OR BACK)

NO USER-SERVICEABLE PARTS INSIDE

REFER SERVICING TO QUALIFIED

SERVICE PERSONNEL.

The lightning flash with arrowhead symbol, within an equilateral triangle, is intended
to alert the user to the presence of uninsulated “dangerous voltage” within the
product’s enclosure that may be of sufficient magnitude to constitute a risk of electric
shock.

The exclamation point within an equilateral triangle is intended to alert the user to the
presence of important operating and maintenance (servicing) instructions in the litera-
ture accompanying the appliance.

WARNING:
TO PREVENT FIRE OR SHOCK HAZARD, DO NOT EXPOSE THIS APPLIANCE TO RAIN OR
MOISTURE.

CAUTION:
TO PREVENT ELECTRIC SHOCK DO NOT USE THIS (POLARIZED) PLUG WITH AN EX-
TENSION CORD, RECEPTACLE OR OTHER OUTLET UNLESS THE BLADES CAN BE
FULLY INSERTED TO PREVENT BLADE EXPOSURE.

NOTE:
SINCE THIS PROJECTOR IS PLUGGABLE EQUIPMENT, THE SOCKET-OUTLET SHALL BE
INSTALLED NEAR THE EQUIPMENT AND SHALL BE EASILY ACCESSIBLE.

WARNING
Use the attached specified power-supply cord.  If
you use another cord, it may cause interference
with radio and television reception.

Use the attached RGB cable, RS-232C cable with
this equipment so as to keep interference within the
limit of a Class A device.

The projector automatically shuts off
when the lamp is used up in about
1,300 hours and not used until  lamp
replacement.

DO NOT LOOK DIRECTLY INTO THE LENS
WHEN PROJECTOR IS IN THE POWER ON
MODE.
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Important safeguards
PLEASE READ ALL THESE INSTRUCTIONS RE-
GARDING YOUR LCD PROJECTOR  AND RETAIN
THEM FOR FUTURE REFERENCE. FOLLOW ALL
WARNINGS AND INSTRUCTIONS MARKED ON
THE  LCD PROJECTOR.

1. Read instructions
All the safety and operating instructions should
be read before the appliance is operated.

2. Retain instructions
The safety and operating instructions should be
retained for future reference.

3. Warnings
All warnings on the appliance and in the oper-
ating instructions should be adhered to.

4. Instructions
All operating instructions must be followed.

5. Cleaning
Unplug this projector from the wall outlet be-
fore cleaning it. Do not use liquid aerosol clean-
ers. Use a damp cloth for cleaning.

6. Attachments and equipment
Never add any attachments and/or equipment
without the approval of the manufacturer as
such additions may result in the risk of fire, elec-
tric shock or other personal injury.

7. Water and moisture
Do not use this projector near water or in con-
tact with water.

8. Accessories
Do not place this projector on an unstable cart,
stand, tripod, bracket or table. Use only with a
cart, stand, tripod bracket, or table recom-
mended by the manufacturer or sold with the
projector. Any mounting of the appliance should
follow the manufacturer's instructions and
should use a mounting accessory recommended
by the manufacturer.

An appliance and cart combination should be
moved with care. Quick stops, excessive force and
uneven surfaces may cause the appliance and
cart combination to overturn.

10. Power sources
This projector should be operated only from the
type of power source indicated on the marking
label. If you are not sure of the type of power
supplied to your office, consult your appliance
dealer or local power company.

11. Power-cord protection
Power-supply cords should be routed so that they
are not likely to be walked on or pinched by items
placed upon or against them. Pay particular at-
tention to cords at plugs, convenience receptacles,
and points where they exit from the appliance.

12. Overloading
Do not overload wall outlets and extension cords
as this can result in a fire or electric shock.

13. Object and liquid entry
Never push objects of any kind through open-
ings of this projector as they may touch danger-
ous voltage points or short-out parts that could
result in a fire or electric shock. Never spill liq-
uid of any kind on the projector.

14. Servicing
Do not attempt to service this projector yourself
as opening or removing covers may expose you
to dangerous voltage or other hazards. Refer all
servicing to qualified service personnel.

15. Damage requiring service
Unplug this projector from the wall outlet and
refer servicing to qualified service personnel un-
der the following conditions:
(a) If the power-supply cord or plug is dam-

aged.
(b) If liquid has been spilled, or objects have

fallen into the projector.
(c) If the projector does not operate normally

after you follow the operating instructions.
Adjust only those controls that are covered
by the operating instructions. An improper
adjustment of other controls may result
in damage and may often require exten-
sive work by a qualified technician to re-
store the projector to its normal operation.

(d) If the projector has been exposed to rain
or water.

(e) If the projector has been dropped or the
cabinet has been damaged.

(f) If the projector exhibits a distinct change
in performance - this indicates a need for
service.

16. Replacement parts
When replacement parts are required, be sure
that the service technician has used replacement
parts specified by the manufacturer or parts
having the same characteristics as the original
part. Unauthorized substitutions may result in
fire, electric shock or other hazards.

17. Safety check
Upon completion of any service or repair to this
projector, ask the service technician to perform
safety checks determining that the projector is
in a safe operating condition.

9. Ventilation
Slots and openings in the cabinet are provided
for ventilation, ensuring reliable operation of the
projector and to protect it from overheating. Do
not block these openings or allow them to be
blocked by placing the projector on a bed, sofa,
rug, or bookcase. Ensure that there is adequate
ventilation and that the manufacturer's instruc-
tions have been adhered to.
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WARNING:
Unplug immediately if there is
something wrong with your projector.
Do not operate if smoke, strange noise or odor comes
out of your projector. It might cause fire or electric
shock. In this case, unplug immediately and contact
your dealer.

Never remove the cabinet.
This projector contains high voltage circuitry. An
inadvertent contact may result in an electric shock.
Except as specifically explained in the Owner's
Guide, do not attempt to service this product
yourself. Please contact your dealer when you want
to fix, adjust or inspect the projector.

Do not modify this equipment.
It can lead to fire or electric shock.

If you break or drop the cabinet.
Do not keep using this equipment if you break or
drop it. Unplug the projector and contact your dealer
for inspection. It may lead to fire if you keep using
the equipment.

Do not face a lens to the sun.
It can lead to fire.

Use correct voltage.
If you use incorrect voltage, it can lead to fire.

Do not place the projector on uneven
surface. Level stable surface only.
Please do not place equipment on unstable surfaces.
Do not look into the lens when it is operating. It may
hurt your eyes.
Never let children look into the lens when it is on.

COMPLIANCE NOTICE OF FCC
This equipment has been tested and found to comply with the limits for a Class A digital device, pursu-
ant to Part 15 of the FCC Rules.  These limits are designed to provide reasonable protection against
harmful interference when the equipment is operated in a commercial environment.  This equipment
generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance
with the instruction manual, may cause harmful interference to radio communications.  Operation of
this equipment in a residential area is likely to cause harmful interference in which case the user will
be required to correct the interference at his own expense.
This digital apparatus does not exceed the Class A limits for radio noise emissions from digital appara-
tus as set out in the interference-causing equipment standard entitled “Digital Apparatus”, ICES-003 of
the Department of Communications.

Changes or modifications not expressly approved by Mitsubishi could void the user's authority to oper-
ate this equipment.

COMPLIANCE NOTICE OF INDUSTRY CANADA
This Class [A] digital apparatus meets all requirements of the Canadian Interference-Causing Equip-
ment Regulations.

Do not turn off the main power
abruptly or unplug the projector
during operation.
It can lead to lamp breakage, fire, electric shock or
other trouble.

Place of installation
Refrain from setting the projector at any place subjected
to high temperature and high humidity. Precision devices
are built into the projector. Please maintain an operating
temperature, humidity, and altitude as specified below
for safety's sake.

• Operating temperature: between +41°F (+5°C) and
+95°F (+35°C)

• Operating humidity:  between 30 and 90%
• Never put any heat-producing device under the pro-

jector so that the projector does not overheat.
• Do not attach the projector to a place that is un-

stable or subject to vibration.
• Do not install the projector near any equipment that

produces a strong magnetic field. Also refrain from
installing near the projector any cable carrying a
large current.

• Place the projector on a solid, vibration free sur-
face: otherwise it may fall, causing serious injury
to a child or adult, and serious damage to the prod-
uct.

• Do not stand the projector: it may fall, causing se-
rious injury and damage to the projector.

• Place the projector within a slope of ±15˚. Slanting
the projector more than ±15˚ may cause trouble or
explosion of the lamp.

• Do not place the projector near air-conditioning unit
or heater to avoid hot air to the exhaust and venti-
lation hole of the projector.
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Overview of the projector

Normal

On Menu

On PC
card Menu

FINE  ( )

Adjust FINE  (-)

Select the setting
item (Left)

Select previous
image (Left)

FINE ( )

Adjust FINE(+)

Select the setting
item (Right)

Select next
image (Right)

FOCUS / ZOOM

FOCUS or ZOOM
setting

Enter the layer
setting

Select the
group (-)

AUTO POSITION

Adjust position
when incorrect

–

Select the
group (+)

lamp lid
Caution:
Do not replace the lamp right after using the projector. The lamp is 
very hot. Switch the projector to stand-by mode, wait at least 120  
seconds for the lamp and LCD panel to cool. Then turn off the main 
power switch, unplug from the outlet and wait for another one hour or 
until the lamp is cool to the touch.  See page 40.

LAMP

RGB MENU
AUTO

POSITIONFINEVIDEO CARD
FOCUS
/ZOOM

ENTER

TEMP CARD 1 CARD 2

PC card indicator
When the PC card is inserted, these indicators light up.  See page 27. 

ª , º
Use to make FOCUS or ZOOM adjustments etc. 
See the table as shown below.

handle
Hold here to carry this projector.

remote control sensor (Front / Rear)

input source 
(RGB, VIDEO, CARD)
Use to select the input 
source you wish to watch. 

menu
Use to project menu display. 

fine (     ,     )
Use to make FINE adjustment etc. See the table as shown below.

power
Use to turn the projector on or off when MAIN POWER is on.  To turn the projector off, press this button twice.
Important:
When the lamp indicator lights up in green, the power switch cannot be used to switch “ON” and “OFF.”
Begin operation only after the indicator has stopped blinking.

 release button
Press to adjust the angle of projection.  See page 11.

exhaust slits

temperature indicator
This informs you of the thermal condition inside the projector. When the inside 
temperature is extremely high, the power automatically shuts off while the indicator 
blinks red.  See page 44. 

power indicator
When the main power switch is on in stand-by mode, this indicator lights up red. When the projector 
is fully "ON", the indicator lights up green.  See page 44.

auto position
Use to adjust the position 
of Personal computer 
image. See page 16.

ª ª

focus / zoom
Use to change the mode of the adjust 
buttons, focus or zoom etc. See the table 
as shown below.

lamp indicator
This informs you of the status of the light source lamp and its service life. When the projector 
lamp is lit, the indicator lights up in green. When operation time of the light source lamp has 
exceeded 1,000 hours, the indicator will flash alternately between red and green (while the lamp 
is in use).  When the lamp is exhausted, the indicator will show red only.  When the lamp is used 
up to 1,300 hours, the projector automatically shuts off. See pages 40 and 44.

FINE, ººººº, ªªªªª,     FOCUS/ZOOM and AUTO POSITION buttons
The operations of these buttons vary as follows depending on the modes selected:

ªªªªª

Adjust FOCUS or
ZOOM  (+)

Set the setting
item

Select
INDEX or FILE

ººººº

Adjust FOCUS or
ZOOM (-)

Set the setting
item

Select
INDEX or FILE
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PC analog RGB input
Use to input video signals (analog
RGB) of a personal computer.

(Pin assignment of Mini D-SUB 15P jack)

PIN NO. SPEC PIN NO. SPEC

1 R(RED)/CR 9 —
2 G(GREEN)/Y 10 GROUND
3 B(BLUE)/CB 11 GROUND
4 GROUND 12 —
5 GROUND 13 HD/CS
6 GROUND 14 VD
7 GROUND 15 —
8 GROUND

15

11

610

15

RS-232C input
Connect here when you control this Projector with a
personal computer using PCGC (personal computer
graphic controller) or with a remote controller using
SpacePointer function.

RS-232C 1 input (D-SUB 9P)
• The Pin assignment is DTE (Data Terminal

Equipment) type.
• Please use RS-232C crossover cable pro-

vided.

1

6 9

5

PIN NO. CODE NAME I/O       NOTE

1 CD Carrier Detect IN not connected
2 RD Receive Data (RXD) IN connected to inner circuit
3 SD Send Data (TXD) OUT connected to inner circuit
4 ER Equipment Ready(DTR) OUT not connected
5 SG Signal Ground connected to inner circuit
6 DR Data Set Ready(DSR) OUT not connected
7 RS Request to Send(RTS) OUT not connected
8 CS Clear to Send (CTS) IN not connected
9 RI Ring Indicator IN not connected

PIN NO. CODE NAME I/O       NOTE

1 RS Request to Send(RTS) OUT not connected
2 CS Clear to Send (CTS) IN not connected
3 SD Send Data (TXD) OUT connected to inner circuit
4 SG Signal Ground connected to inner circuit
5 RD Receive Data (RXD) IN connected to inner circuit
6 – not connected
7 – not connected
8 – not connected

8

1

6

2

5 3

RGB2 IN

RGB OUT

LINE-OUT

AUDIO AUDIO

MAIN

VIDEO

AC  IN

L

R

INPUT1 INPUT2

RS-232C 2

O I

S-VIDEO

RS-232C 1

RGB1 IN

PC card insert slot
This is where you insert the PC card.   
See page 27.

power jack

MAIN power
I  : ON
O : OFF

RS-232 2 input (Mini DIN 8P)
Connects to personal computer when using 
SpacePointer (RGB2 IN). See page 37.

PC analog RGB output
 (mini D-SUB 15P)
Use to output RGB signal from 
RGB1 OR RGB2 input. See pages 
13 - 15.

PC audio input (stereo mini jack)
Use to input PC audio signals. See pages 
13 - 15.

PC analog RGB input (mini D-SUB 15P)
Use to input RGB signal for PC. See pages 
13 - 15.

RS-232 1 input (D-SUB 9P)
Connects to personal computer 
when using SpacePointer (RGB1 
IN), accessory PCGC and so on. 
See pages 35 and 37.

PC card eject
Press to eject the PC card.  See page 27.

video/audio input
Use to input video and 
audio. See page 12.

line output
Use to output PC audio if PC audio in, or 
Audio input 1 or 2 is connected. See pages 
12 - 15. 

RGB2 IN

RGB OUT

LINE-OUT

AUDIO AUDIO

MAIN

VIDEO

AC  IN

L

R

INPUT1 INPUT2

RS-232C 2

O I

S-VIDEO

RS-232C 1

RGB1 IN

RS-232C 2 input (Mini DIN 8P)
• Please use RS-232C crossover cable and MAC

adaptor for RS-232C cable provided.

(Pin assignment of D-SUB 9P)
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Overview of the remote control

The operations of these buttons varies as follows depending on the modes selected:

Normal

On Menu

On PC
card Menu

PinP

EXPAND

$$$$$

Adjust FINE  (-)

Select the setting
item (Left)

Select previous
image (Left)

Exchange the image
(main or sub)

Expand different
area (Left)

%%%%%

Adjust FINE(+)

Select the setting
item (Right)

Select next
image (Right)

Exchange the image
(main or sub)

Expand different
area (Right)

}}}}}

Adjust FOCUS or
ZOOM (-)

Set the setting
item

Select
INDEX or FILE

Switch still pictures
(main or sub)

Expand different
area (Down)

{{{{{

Adjust FOCUS or
ZOOM  (+)

Set the setting
item

Select
INDEX or FILE

Switch still pictures
(main or sub)

Expand different
area (Up)

–  (VOL)

Volume down

–

Select the
group (-)

Recapture of the
still picture

Set the expand
rate (-)

+  (VOL)

Volume up

–

Select the
group (+)

Recapture of the
still picture

Set the expand
rate (+)

focus / zoom
Use to change FOCUS or ZOOM mode.
See page 17.

start/stop
Use to turn the PC control mode or 
cursor operation mode on or off. 
See pages 25, 38.

cancel
This operates in the same way as the 
right button on the computer mouse. 
If this button is pressed during 
drawing mode, the figure will 
diappear. See pages 25, 38.

input source 
(RGB, VIDEO, CARD)
Use to select the input source you wish to 
watch. If this button is pressed during PinP 
mode, the input signal of sub image will be 
changed. See page 16.

volume (-)
Press to turn the volume down. See the 
table as shown below. 

PinP
Press to turn on the PinP  (Picture in 
Picture) image, or to cancel it. See page 26. 

{, }, $, %
Used for MENU setting. See the 
table as shown below. 

volume (+)
Press to turn the volume up. See the 
table as shown below. 

enter/still
Used for MENU setting. Also, use to 
freeze the image. See pages 18 and 25.

cursor
Press to display the cursor. Also 
used to change the mode of PC 
control or cursor operation, when 
the projector  is connected to a 
personal computer with RS-232C. 
See pages 25 and 38. 

auto position
Use to adjust the position of Personal 
computer image. See page 16.

power
Use to turn the projector on or off 
when MAIN POWER is on. To 
turn the projector off, press this 
button twice. See page 22.

menu
Press to display MENU selection bar. 
Exit the menu system by pressing the 
MENU button during displaying MENU 
display. See page 18.

double click
This operates in the same way as 
double clicking the left button on the 
computer mouse.  See pages 25, 38.

select
This operates in the same way as the 
left button on the computer mouse.  By 
pressing this button during the drawing 
mode can set the start and end point of 
the figure. See pages 25, 38.

operation indicator
When the operation button is 
pressed, this indicator blinks. It also 
illuminates when the projector is in 
the personal computer mode or 
drawing mode which is able to have 
a cursor operation. See pages 25, 38.

expand
Use to expand the image. See page 26. 

card auto play 
Press to start auto play function of the 
PC CARD. See page 28. 

PC card release
Press this button to be able to eject 
PC card. Make sure to press this 
button all the time to eject the PC 
card. See page 27. 

+(VOL)

CARD

RELEASE
AUTO

POSITION

RGB

MENU
FOCUS
/ZOOM

VIDEO

START/STOP

SELECT

PinP

POWER

PC CARD

CURSOR

DOUBLE
CLICK

CANCEL

-(VOL)

ENTER
/STILL

EXPAND

AUTO PLAY
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Important:
• To save battery power, turn off the operation indicator by pressing the START/STOP button when not in use.
• To save battery power, the operation indicator will turn off if the remote control is not operated for a period of

5 minutes.

Battery installation
Use two AA size batteries.
1. Remove the back cover of the remote control by pushing the battery compartment door in the direction of the

arrow.

2. Load the batteries making sure that they are positioned correctly (+ to +, and - to -).

3. Replace the back cover.

Important:
• Do not use a new battery with an old one.
• Load batteries in the correct position.
• Do not heat, take apart, or throw batteries into fire.
• Do not try to recharge batteries.  Do not use rechargeable batteries.
• If the alkaline solution of alkaline batteries comes in contact with your skin or clothes, rinse with water.  If

the solution comes in contact with your eyes, rinse them with water and then consult your doctor.

Operation area
The range for operation is about 10m when the remote points to the projector.  When using the remote control for
SpacePointer, the range for operation is about 7m.  The distance to the screen back to the projector must be less
than 7m.

Important:
Avoid the direct sunlight or fluorescent light to the remote control sensor. Also keep the distance of more than 2 m
between the remote control sensor and fluorescent lamp.  The remote may not work correctly.

20˚

15˚

20˚

15˚

30˚30˚

20˚ 20˚

1 2 3
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Preparing the projector for operation
Orientation of the projector
Picture size can be set by changing the distance between the screen and the projector.
Front projection To find the approximate distance

between the projector and screen:
Multiply the width of the screen
x 1.875 ~ 1.975 (max.) ,
Multiply the width of the screen
x 2.468 ~ 2.57 (min.) ,
• Refer to the chart to recom-

mended distances in maximum
zoom and minimum zoom.

Diagonal size
 (inch)

40 "
60 "
80 "
100 "
120 "
140 "
160 "
180 "
200 "
300 "

Height inches
 (inch)

24 "
36 "
48 "
60 "
72 "
84 "
96 "

108 "
120 "
180 "

Width feet
 (inch)

32 "
48 "
64 "
80 "
96 "
112 "
128 "
144 "
160 "
240 "

Screen Distance from screen (L) / (approximate)
Maximum

zoom (min.)
(mm)
1527
2335
3143
3951
4758
5566
6374
7182
7990
12029

(mm)
2012
3062
4112
5162
6213
7263
8313
9363
10413

–

(inch)
60.12"
91.93"
123.74"
155.55"
187.32"
219.13"
250.94"
282.75"
314.57"
473.58"

(inch)
79.21"

120.55"
161.89"
203.23"
244.61"
285.94"
327.28"
368.62"
409.96"

–

Height projected
image (H)

/ (approximate)
(inch)
3.0"
4.49"
5.98"
7.52"
9.02"
10.51"
12.0"
13.5"
15.0"
22.52"

(mm)
76
114
152
191
229
267
305
343
381
572

SCREEN

Front projection, ceiling mount
For ceiling mount, you need the ceiling mount metal
etc.  Also ask specialist for installation.  For more
detail, ask your dealer.

• When the use of ceiling mount, set IMAGE
REVERSE in INSTALLATION menu to INVERT.
You can not use KEYSTONE when IMAGE
REVERSE is INVERT.  See Page 20.

• Projected images may appear darker when the
unit is used as a ceiling installation than when it
is used in the tabletop position. This does not
signify a product malfunction.

Rear projection
Also ask specialist for installation.  For more detail,
ask your dealer.

Minimum
zoom (max.)

SCREEN

• For rear projection, set IMAGE REVERSE in
INSTALLATION menu to MIRROR.  See Page 20.

Caution:
• Placing the projector on a carpet reduces ventila-

tion from the fan on the bottom and might cause
problems. Place a hard board or similar item
under the projector to facilitate ventilation of the
unit.

• Place the projector more than 20 in. from the wall
to prevent blocking the intake, exhaust slots and
ventilation of this projector because hot air comes
out of it.

• Do not use the projector under the following
circumstances, which may cause fire or electric
shock.
• in a dusty or humid place
• while the projector is lying sideways or upside

down.
• near a heater
• in a kitchen or oily, smoky or damp place
• in direct sunlight
• where the temperature is lower than 41°F or

higher than 95°F

Important:
• Do not put stress on the lens or focus ring, as this

may damage them.
• Keep your room dark while using the projector. The

image cannot be seen clearly in a bright place.

L (between the screen and center 
of the head of the lens-barrel)

H (height)

screen
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Adjusting the angle of projection
Screen on a flat wall with a 90 degree angle to the floor
by adjusting two foot adjustments on the bottom of the
projector.  If the angle cannot be corrected by them,
adjust the height and angle of screen.

1. Lift the projector to the right angle.

2. Press the release button for angle adjustment to take
the adjustment feet out of the projector.

3. Release the button and keep your hands away from
the projector.

4. Turn the both feet to right or left to adjust for proper
angle.

After using the projection,
5. Press the release button to take the projector down

slowly with holding it.

Important:
The image becomes trapezoid shape when the screen
or project is not level.  Use KEYSTONE in ENHANCED
menu to adjust, however, the circumference of the im-
age may not be focused. See page 20.

• Screen on a flat wall with a 90˚ angle to the floor.
• Align projector to produce a full screen display as

illustrated on page 10.
• Distance from projector to screen must be

compatible with screen size chart on page 10. Note
distance from screen chart.

• If image is not square on screen, try adjusting the
front feet of the projector for proper angle.

Getting ready for projection

1. Connect the power cord provided to this projector
with the power jack of the projector.

2. Connect the power cord to the wall outlet.

3. Take off the lens cap.
4. Do not look directly into the lens when projector is

“ON”.

Warning:
• The lens cap is for protecting the lens.  If you leave

the power on with the cap on, the cap may be warped.
Please remove the lens cap when you turn the power
on.

• A three-pin grounding type power plug is used with
the projector. Do not remove the grounding pin on
the power plug. If you are unable to insert the plug
into the outlet, contact your electrician to replace
your obsolete outlet.

• The supplied power cord is used for 120V only. Never
connect to any outlet or power supply having a dif-
ferent voltage or frequency. If you connect to the
power supply having a different voltage, please use
the appropriate power cord.

• Do not place an object on the power cord and keep
the projector away from heat source to avoid break-
ing the power cord. A broken of power cord can cause
fire or electric shock.

• Do not revise or alter the power cord otherwise it
may cause fire or electric  shock.
Contact your dealer if the cord is broken.

Caution:
• Plug in firmly and unplug by holding the plug, not

by pulling the cable out.
• Do not plug in or out  with wet hands.  It may cause

an electric shock.

Plug in the provided
power cord directly.

ground
terminal

foot adjustment
screen
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Cables and adapters
To connect personal computers to this projector, the following cables and adapters are necessary.  The overview
might be different from the picture below.

RGB cables  (mini D-SUB 15P plug)

.

Note: The pins numbered 5, 9, 12 and 15 are not connected.

RGB Conversion adapter for MAC
 (mini D-SUB 15P plug - D-SUB 15P plug)

Basic connections
This projector can be connected to equipment such as VCRs, video cameras, videodisc players, and personal comput-
ers having analog RGB input.

Important:
• Make sure that your equipment is turned off before connection.
• Match the color of video and audio plugs on the AV cable with each terminal.
• Plug in firmly and unplug by holding the plug, not by pulling the cable out.
• If connected units are set too close to one another, the image may be affected. Setting connected units too close

to one another affects the image.
• Refer to the owner's guide of each component for details of connections, .

Projector + AV equipment
Make sure that your equipment is turned off before connection.

Important:
S-video signals take priority over video signals. If you input both S-video signals and normal video signals at the
same time, the normal video input automatically shuts off.

to audio
output

to video
output

to S-video
output

to audio
output

to video
output

Connect either one of these.

DVD player, others

to audio input 2

to S-video 
input 2

to video input 2

to audio input 1

to video 
input 1

VCR, others

RCA/BNC
adaptor

Projector + DVD player
Some DVD players have output terminal for 3 line fitting (Y, CB,
CR).  When connecting them to the projector, connect to RGB-1 or
RGB-2 of the projector.  In this case, set “Y, CB, CR” for RGB/Y, CB,
CR setting in SIGNAL SETTING MENU.

to RGB 1 IN 
or RGB 2 IN

G R B 

CB Y CR 

H
D

/C
S

V
D

 

DVD player

No connection

• Use mini D-SUB 15 pin-BNC conversion cable for connection.
• Some DVD player may not project the image correctly.

PIN NO.
1
2
3

13
14
15

PIN NO.
1
2
3

13
14
15

MINI D-SUB 15P MINI D-SUB 15P

MINI D-SUB 15P D-SUB15P

1
2

3
4

5
6

O
N

D
IP

Note: Set the dip switch to the appropriate position.

%

Display Resolution Dip switch
mode 1 2 3 4 5 6

13 inch 640 × 480 ON ON OFF OFF OFF OFF
16 inch 832 × 624 OFF ON OFF ON OFF OFF
19 inch 1024 × 768 OFF ON ON OFF OFF OFF
21 inch 1152 × 870 ON ON ON ON OFF OFF

PIN NO.
1
3
5
8
2
4
6

12
14
15

        SHELL

PIN NO.
1
2
3
5
6
7
8

10
13
14

SHELL      

MINI D-SUB 15P D-SUB15P

RGB Conversion adapter for NEC PC (Option)
 (mini D-SUB 15P plug - D-SUB 15P plug)
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Projector + IBM PC or IBM PC compatibles
Make sure that your equipment is turned off before connection.

Important:
• Connectors or analog RGB output adapters may be necessary depending on the personal computer connected to

this projector.  Please contact your dealer.
• The audio input for a personal computer is the stereo mini-jack. There are some personal computers that have

different types of audio outputs or none at all. Please ask your dealer for details.
• For connection details, refer to the owner's guide of each component.

to VGA
monitor port

to VGA
monitor port

desktop computer

notebook computer RGB cable

to PC audio 
output to RGB1 IN

to AUDIO

When outputting to both a PC monitor and the projector

to VGA
monitor port

desktop computer

RGB cable

RGB cable

to AUDIO

to PC audio 
output

to PC 
monitor

to RGB 1 IN

to RGB OUT
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Projector + Macintosh
Make sure that your equipment is turned off before connection.

Important:
• A monitor output adapter is necessary for a Macintosh if it has no video port. Contact your dealer.
• If you use the RGB conversion adapter provided, set the dip switch to the appropriate position. See page 12.
• Connectors or analog RGB output adapters may be necessary depending on the personal computer connected to

this projector.  Please contact your dealer.
• The audio input for a personal computer is the stereo mini jack. There are some personal computers that have

different types of audio outputs or none at all. Please ask your dealer for details.
• For connection details, refer to the owner's guide for each component.
• When outputting to both a PC monitor and the projector, use an Apple Macintosh monitor or multiscan monitor

corresponding to Composite Sync.

to video port

to video port

desktop computer

Power Book RGB Conversion
adapter for MAC

RGB cable

to AUDIO

to PC audio 
output

to RGB 1 IN

1
2

3
4

5
6

O
N

D
IP

When outputting to both a PC monitor and the projector

to video port
desktop 
computer

RGB Conversion
adapter for MAC

Monitor 
Conversion
adapter

RGB cable

Monitor cable

to AUDIO

to PC audio 
output

to PC
monitor

to RGB 1 IN

to RGB OUT

1
2

3
4

5
6

O
N

D
IP

Basic connections (continue)
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Projector + NEC PC-98 series
Make sure that your equipment is turned off before connection.

Important:
• Connectors or analog RGB output adapters may be necessary depending on the personal computer connected to

this projector.  Please contact your dealer.
• The audio input for a personal computer is the stereo mini jack. There are some personal computers that have

different type or no audio outputs. Please ask your dealer for details.
• For connection details, refer to the owner's guide of each component.

to AUDIO

desktop computer

RGB cable

to analog RGB display 
connector

notebook computer
RGB Conversion
adapter for NEC
PC (option)

to analog RGB
display connector

to PC audio 
output

to RGB 1 IN

When outputting to both a PC monitor and the projector

to AUDIO

desktop computer

RGB cableRGB Conversion
adapter for NEC
PC (option)

Monitor cable

Monitor 
Conversion
adapter

to analog RGB
display connector

to PC audio 
output

to RGB 1 IN

to PC
monitor to RGB OUT
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To operate projector power ON
Numbers 1 - 9 correspond to the instruction numbers below.

Important:
• A darkened image may be seen right after pressing

the POWER button  due to warming up of this pro-
jector. When warming up, no other commands can
be accepted.

• When the lamp indicator is blinking red, the ser-
vice life of the lamp is about to end.  Replace the
lamp. See pages 40 and 44.

• The picture might not be of optimum performance
in extreme hot or cold conditions. (The projector is
not malfunctioning.)

4.  Select the desired external input source by using
the RGB or VIDEO button.

• The projector automatically selects the appropriate
signal system. The selected signal system is dis-
played on the SIGNAL menu.

• When selecting the RGB1 or RGB2 input, the im-
age may be flickered.  Press the FINE buttons to
adjust the image.

• Press CARD button to see the PC CARD images.
(You cannot select it when CARD 1 or CARD 2 indi-
cator is not lighting up.)

1. Put the projector into standby mode by pressing the
main power switch. The POWER indicator lights up
red.

2. Turn on the equipment connected to the projector.

3. Turn the projector on by pressing the POWER but-
ton.
The light source lamp starts warming up, eventu-
ally turn on.  In cases where light source lamp does
not come on, wait for one minute before switching
power on again.
• If power to the main unit is turned off within

two minutes of turning off the light source
lamp, power will not be introduced to the lamp
for one minute the next time the main unit
power switch is turned on. When this happens,
the indicator lamp will blink for one minute.

RGB1 IN

RGB2 IN

RGB OUT

LINE
-OUT

AUDIO AUDIO

MAIN

VIDEO

AC  IN

L

R

INPUT1 INPUT2

RS-232C 1 RS-232C 2

O I

S-VIDEO

2,  9
Left side

AUTO position 
button

LAMP

RGB MENU
AUTO

POSITIONFINEVIDEO CARD
FOCUS
/ZOOM

ENTER

TEMP CARD 1 CARD 2

4 4 563, 7, 8

condition
indicator LAMP POWER

stand-by - red
when light source lamp is on green green

when light source lamp does not light up red-
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AUTO POSITION button
When the source is selected to RGB1 or RGB2 and
the image is not in the right place, set to display as
blightest signal as possible, then press the AUTO
POSITION button. If the image is still not in the
right place.
• Set screen to the brightest display possible (e.g.,

full-screen display of the “Trash” window) before
deploying the automatic adjustment function.

• If the screen saver is running, turn off the screen
saver before using the automatic adjustment
button.

5.   Press the FOCUS/ZOOM button to FOCUS. “FO-
CUS” will appear on the display.

6. Adjust with the ª or º buttons on the control
panel (or { or } buttons on the remote control) to
get a fine picture.

• Focus and zoom adjustment by using the buttons on
the control panel or the remote control is possible in
the normal picture mode only. In PinP, EXPAND or
cursor operation mode, the adjustment is impossible.

The volume from the speaker
Press the VOLUME buttons on the remote control to
change the volume from the speaker.  You can also
change it by selecting the volume in AUDIO menu.
When setting “ON” for MUTE in AUDIO menu, you
can stop the sound momentary.
• The volume button does not work when MENU se-

lecting bar or MENU is displayed.

Turning off the projector
7. Press the POWER button.

The message “POWER OFF? YES : PRESS AGAIN”
appears on the screen.
• To exit from this mode,  press any button except

POWER button.

8. Press the POWER button again.
The light source lamp will be turned off.
By pressing the POWER button again, shuts off the
light source lamp, but the exhaust fan continues to
operate for 120 seconds to cool down the light source
lamp and LCD panels. In this time, the lamp indica-
tor will be turned off from flashing.

9. Turn off the main power switch. When turning off
the main switch, the POWER indicator turns off.

• In cases where the main power switch is acciden-
tally turned off when either the intake/exhaust
fan or the power source lamp is in operation, allow
the unit to cool down for 10 minutes with the
power turned off. Repeat step 3 when turning on
the power source lamp. If the lamp does not turn
on immediately, repeat this step two or three
times. Replace the lamp if it should still fail to
turn on.

Caution:
• When you have finished using this equipment, wait

120 seconds for the exhaust fans to stop. Then turn
off the main switch and unplug the power cable from
the wall outlet, for safety purposes.

• After the lamp is turned off,  the lamp cannot be
switched on again for 60 seconds as a precaution-
ary measure. It will take another 60 seconds before
the lamp indicator goes off. If you wish to turn on
the projector again, wait until the indicator is off
then press the POWER button.

• The exhaust fans faster automatically when the tem-
perature around the projector becomes high.

• When the temperature around the projector becomes
much higher, the sign of “TEMP!!” blinks red on the
screen. If the temperature stays in high, the lamp will
be shut off automatically .

The projector automatically shuts off when the
lamp is used up in about 1,300 hours and not used
until  lamp replacement.
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Basic operation
Several settings can be adjusted using Menu.

EXAMPLE: Brightness adjustment

1.  Press the MENU button.

2.  Press the  or buttons on the control panel (or
$ or % buttons on the remote control) to select
PICTURE.

3.  Press the ª or º buttons on the control panel (or
{ or } buttons on the remote control).

4.  Press the  or buttons on the control panel (or
$ or % buttons on the remote control) to select
BRIGHTNESS.

5.  Press the ª or º buttons on the control panel (or
{ or } buttons on the remote control) to adjust
brightness.

If you wish to change the color balance, follow
the steps below.

6.  Press the  or buttons on the control panel (or
$ or % buttons on the remote control) to select
USER and press the ENTER button.

AUDIOPC CARD
AUTO PLAY

PinP/
EXPANDPICTURESIGNAL

AUDIOPC CARD
AUTO PLAY

PinP/
EXPANDPICTURESIGNAL

CONTRAST BRIGHTNESS TINT COLOR GAMMA
CORRECTION

0 0 0 0
USERUSERUSER

OPTIONINSTALLATIONAUDIOPC CARD
AUTO PLAY

PinP/
EXPANDSIGNAL PICTURE

CONTRAST BRIGHTNESS TINT COLOR GAMMA
CORRECTION

0 0 0 0
USERUSERUSER

OPTIONINSTALLATIONAUDIOPC CARD
AUTO PLAY

PinP/
EXPANDSIGNAL PICTURE

CONTRAST BRIGHTNESS TINT COLOR GAMMA
CORRECTION

0 15 0 0
USERUSERUSER

OPTIONINSTALLATIONAUDIOPC CARD
AUTO PLAY

PinP/
EXPANDSIGNAL PICTURE

151515

B
BRIGHTNESS

GR

7.  Press the  or buttons on the control panel (or
$ or % buttons on the remote control) to select the
desired color R, G or B.

8.  Press the ª or º buttons on the control panel (or
{ or } buttons on the remote control) to adjust
brightness of the desired color.

9.  Exit the menu system by pressing the MENU but-
ton several times.

• If the menu operation is not working, simultaneously
press the MENU and POWER button.

• To switch back to the factory preset of each menu,
select RESET and press the ENTER button.

• When selecting RESET, the buttons cannot be oper-
ated for 2 to 18 seconds.

151515

B
BRIGHTNESS

GR

15-1515

B
BRIGHTNESS

GR

Menu operation
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AUTO .................. Use to select AUTO, USER 1 or USER 2.
HORIZ. POSITION .... Use to adjust the horizontal position of the image.
VERT. POSITION ..... Use to adjust the vertical position of the image.
FINE SYNC. ....... Use to synchronize the projector with PC input signals so that the image is not blurred.

TRACKING ......... Use to avoid image noise such as wide stripes.
RGB/Y, CB, CR ......... The unit adjusts itself automatically when connected to either DVD players with a

component video output terminal (Y, CB, CR or Y, PB, PR) or equipment with HDTV signal
output capabilities. In cases where the unit is connected to equipment that include an RGB
output terminal and which output HDTV signals, adjust the unit to RGB mode.

Qa SIGNAL  - USER (Normally, there is no need for adjustments.)

CLAMP POSITION/
CLAMP WIDTH ......... If you use a PC video card or something similar, the lighter colors of the projected image

may become blurred. In this case, adjust CLAMP POSITION or CLAMP WIDTH.
HORIZ. PIXELS .... Use to adjust the height of the image. The image size grows higher as the number

increases. (Adjust to the horizontal pixels of inputting signal for normal setting.)
VERT. LINES ..... Use to adjust the width of the image. The image size grows wider as the number increases.

(Adjust to the vertical lines of inputting signal for normal setting.)
PLL ...................... Use to adjust the image which upper right side is awry.  Select AUTO for normal setting.
VERT. SYNC. ..... Use to adjust the image when its motion does not run naturally.  Select AUTO for normal

setting.
HOLD .................. Adjusts the image which upper right side is awry.

W  PICTURE

CONTRAST ........ Adjusts the picture contrast. The contrast becomes higher as the number increases.
BRIGHTNESS .... Adjusts image brightness. The image becomes brighter as the number increases.
TINT .................... Adjusts the color balance in the image.  The color balance of the image shifts green as the

number increases and shifts to purple as the number decreases (only when NTSC or 4.43
NTSC is selected).

COLOR ................  Adjusts the color intensity of the image(only when NTSC, PAL, SECAM or 4.43 NTSC is
selected).

GAMMA
CORRECTION ... Corrects the proportion of the brightness of input signals to that of output signals.  Also

corrects the contrast of projected images.

Q W E R T Y U I

MENU

OPTION Ver.INSTALLATIONAUDIOPC CARD
AUTO PLAY

PinP/
EXPANDPICTURESIGNAL

or or or or or or or or

AUTO

AUTO

USER1

USER2

SXGA70a 0 0 0

RGB

Y,CB,CR

USER

HORIZ.
POSITION

VERT.
POSITION FINE SYNC. TRACKING RGB/Y,CB,CR

0
MEMORIZE

DELETE

RESET

OPTION Ver.INSTALLATIONAUDIOPC CARD
AUTO PLAY

PinP/
EXPANDPICTURESIGNAL

Qa
ENTER
/STILL

33 33

33

3333 3333

AUTO AUTO

ON

OFF

AUTO

BEGIN

CLAMP
POSITION

CLAMP
WIDTH

HORIZ.
PIXELS

VERT.
LINES

VERT.
SYNC.

SIGNAL - USER

PLL HOLD

33

ENDON

OFF

FAST

NORMAL

SLOW

CONTRAST BRIGHTNESS TINT COLOR GAMNMA
CORRECTION

0 0 0 0
USERUSERUSER

OPTION Ver.INSTALLATIONAUDIOPC CARD
AUTO PLAY

PinP/
EXPANDPICTURESIGNAL
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E  PinP/EXPAND
This menu appears when either the display enlargement or PinP functions are used.

ZOOM MODE ..... Selects the desired type of expand mode, type1, 2, 3 or 4 (Actual size display).
POSITION .......... Selects the desired position of the sub image in expand or PinP mode.
SIZE .................... Selects the desired size of the sub image in expand or PinP mode.
AUTO PIP ........... Sets to move the position of PinP pictures automatically or not, when it appears on the red

frame which shows the PinP part.
R  PC CARD AUTO PLAY

AUTO SLIDE
TIME ................... Sets the length of time before the image switches to the next image in PC CARD automatic

playback mode.
REPEAT .............. Sets to repeatedly playback the PC CARD presentation or not in PC CARD automatic

playback mode.
ICON ................... Select wether to addition of card icon of PC card.  Even the setting is OFF, if you press the PC

card end button on the remote control, the card icon will automatically appear.

T  AUDIO

VOLUME ............ Adjusts the volume of sound. The volume becomes louder as the number increases.
MUTE .................. Use to set MUTE on or off. Select ON to switch off the sound. Select OFF to switch the sound

back on.

Y  INSTALLATION

IMAGE REVERSE Use to reverse or invert the projected image. MIRROR is used for rear projection.  INVERT
is effective when the projector is ceiling-mounted.

KEYSTONE ........ Adjusts keystone correction of the image. If the image becomes keystone distortion, select
the approximate setting. For normal use, select 0˚. You can use it only when IMAGE
REVERSE is OFF.

AUTO POWER ON .... To select wether to boot up automatically when the power is turned on by a breaker. In this
case, the main power of the projector has to be ON.  Set this when the projector is hanging on
the ceiling.
• The projector is in stand-by mode when the lamp does not come on. In this case, use the

remote control to turn on the lamp.
TEST SIGNAL .... Use to display the built-in test pattern on the screen.

• The display will disappear when the setting is OFF or press the button except MENU,
ZOOM/FOCUS, ª , º , { ,}and START/STOP.

Menu operation (continue)

33 sec.
ON

OFF

ON

OFF

REPEATAUTO SLIDE
TIME ICON

OPTION Ver.INSTALLATIONAUDIOPC CARD
AUTO PLAY

PinP/
EXPANDPICTURESIGNAL

VOLUME MUTE

ON
30

OFF

OPTION Ver.INSTALLATIONAUDIOPC CARD
AUTO PLAY

PinP/
EXPANDPICTURESIGNAL

IMAGE
REVERSE KEYSTONE

AUTO
POWER ON

TEST
SIGNAL

OFF 0˚

3˚

6˚

9˚

12˚

15˚

OFF

1

2

3

4

MIRROR

INVERT

INVERT

MIRROR,

ON

OFF

OPTION Ver.INSTALLATIONAUDIOPC CARD
AUTO PLAY

PinP/
EXPANDPICTURESIGNAL

ZOOM
MODE

AUTO
PIPPOSITION SIZE

1 1

2

3

4

5

2

3

4

1 ON

OFF2

3

OPTION Ver.INSTALLATIONAUDIOPC CARD
AUTO PLAY

PinP/
EXPANDPICTURESIGNAL
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U  OPTION

MOTION/STILL . Select MOTION when motion images are mainly projected.  Select STILL when still images
such as PC-CARD images are mainly projected.  It works only when inputting personal
computers of SXGA signals or inputting video signal.

SQUEEZE ........... Set to switch the normal image (4:3) and HDTV (16:9) automatically or not, depending on the
image signals.

MENU POSITION . Use to select the position where the menu is displayed (top or bottom on the screen).
AUTO POWER OFF .. Use to select the length of time before the projector switches to standby when there is no

input signal selected source. Select OFF to cancel this function.
REMOTE POSITION Select either FRONT or REAR to receive the infrared signal from the remote control. Select

AUTO for normal setting.
Note: When the remote position is changed with AUTO setting, the buttons cannot be

operated for about 3 seconds.
SIGNAL .............. When AUTO is set, the appropriate video standard is automatically selected according to the

input signal. If the image does not appear correctly, select the desired video standard
manually. Adjust the unit to the appropriate format when the unit either is not projecting
normally in auto mode or is inputting PAL-M/PAL-N signals.

RGB OUTPUT .... Use to select the output image from the personal computer terminal (RGB OUT).  When
selecting AUTO, the terminal images which signals are input are projected.  When a video
signal or PC card is displayed, the unit will project the image sent from the PC input terminal
last displayed.

LANGUAGE ....... Use to select the language for the projector display such as menu.

U  Ver.

Ver. ............................... Displays the version of the installed software.

MOTION
/STILL

MENU
POSITION

AUTO
POWER OFF

REMOTE
POSITION

VIDEO
SIGNAL

RGB
OUTPUTSQUEEZE LANGUAGE

min. English

Español

Deutsch

Français

Italiano

AUTO

MOTION

STILL

AUTO

NTSC

PAL

SECAM

4.43NTSC

PAL-M

PAL-N

AUTO

RGB1

RGB2

ON

OFF

1

2

ON

OFF

5

FRONT

REAR

OPTION Ver.INSTALLATIONAUDIOPC CARD
AUTO PLAY

PinP/
EXPANDPICTURESIGNAL

Ver. 3.3

OPTION Ver.INSTALLATIONAUDIOPC CARD
AUTO PLAY

PinP/
EXPANDPICTURESIGNAL
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Adjustment from personal computer
Although this projector sets proper signal systems
automatically for the image signal from personal
computers, it cannot be applied to some of personal
computers.  In this case, press AUTO POSITION
button.  If the images are still not projected correctly,
use MENU display to adjust the projected images
from personal computers.  Also available to memorize
the setting.
Adjusting the images form personal
computers in MENU display
Adjust as below for the following symptoms.

Image moves to right or left :
Adjust HORIZ. POSITION in SIGNAL menu.  Press
the º button on the control panel (or } button on
the remote control) to move the image to left.  Press
the ª button on the control panel (or { button on
the remote control) to move the image to right.

Image moves to up or down :
Adjust VERT. POSITION in SIGNAL menu.  Press
the º button on the control panel (or } button on
the remote control) to move the image to upward.
Press the ª button on the control panel (or {
button on the remote control) to move the image to
down.

Image flickers / Image is out of focus :
Adjust FINE SYNC. in SIGNAL menu.

Wide stripes appear :
Adjust CLAMP POSITION or CLAMP WIDTH of
each menu in SIGNAL - USER menu.

Noise etc. appears on right or left side of image:
Adjust HORIZ. PIXELS of the menu in SIGNAL -
USER menu.

Noise etc. appears on top or bottom part of image :
Adjust VERT. LINES of the menu in SIGNAL -
USER menu.

Top part of image curves :
Change the setting of PLL or HOLD of the menu in
SIGNAL - USER menu.

PLL .......Select FAST, NORMAL, or SLOW for
image which top part is the least curved.
Select AUTO for normal setting.

HOLD ...Select ON, and adjust BEGIN or END
for image which top part is the least
curved.

Image does not move naturally :
Adjust VERT. SYNC. of the menu in SIGNAL - USER
menu.  Select AUTO for normal setting.

• Do not change each menu setting in SIGNAL -
USER menu for normal setting.

Memorizing the setting
1. Select MEMORIZE in SIGNAL menu, and press

ENTER button.
2. Press the button on the control panel (or %

button on the remote control).
3. Press theª or ºbuttons on the control panel (or

{ or } buttons on the remote control) to select
the memory which you wish to record (USER 1 or
USER 2)

4. Press ENTER button.

Initializing the setting which has been changed
Select DELETE in SIGNAL menu, and press ENTER
button.
•  While INITIALIZING, buttons do not work about

2 - 18 seconds.  Use them to operate after initial-
izing is finished.

Seeing images in recorded setting.
Select AUTO in SIGNAL menu, and press theª or
ºbuttons on the control panel (or { or } buttons
on the remote control) to select the memory (USER1
or USER2).

Resetting the recorded setting
1. Select RESET in SIGNAL menu, and press EN-

TER button.
2. Press the button on the control panel (or %

button on the remote control).
3. Press theª or º buttons on the control panel (or

{ or } buttons on the remote control) to select
the memory which you wish to reset (USER 1 or
USER 2).

4. Press ENTER button
The recorded setting will be reset.

The simple way of adjustment
1. Horizontal position:

Adjust the start position (the left end) using
HORIZ. POSITION, and adjust the end position
(the right end) using TRACKING.  Then repeat
these steps.

2. Vertical position:
Adjust the start position using VERT. POSITION.

AUTO

AUTO

USER1

USER2

SXGA70a 0 0 0

RGB

Y,CB,CR

USER

HORIZ.
POSITION

VERT.
POSITION FINE SYNC. TRACKING RGB/Y,CB,CR

0
MEMORIZE

DELETE

RESET

OPTION Ver.INSTALLATIONAUDIOPC CARD
AUTO PLAY

PinP/
EXPANDPICTURESIGNAL

Picture adjustment

33 33

33

3333 3333

AUTO AUTO

ON

OFF

AUTO

BEGIN

CLAMP
POSITION

CLAMP
WIDTH

HORIZ.
PIXELS

VERT.
LINES

VERT.
SYNC.

SIGNAL - USER

PLL HOLD

33

ENDON

OFF

FAST

NORMAL

SLOW
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Specification of RGB signals in each computer mode of the projector

Signal mode resolution horizontal Vertical Normal Native
 (H x V) frequency (kHz) frequency (Hz) (H x V)  (H x V)

TV60 – 15.73 59.94 1024 x 768 (640 x 480)
TV50 – 15.63 50.00 1024 x 768 (640 x 480)
HiVision – 33.75 60.00 1024 x 576 (882 x 496)
PC98 640 x 400 24.82 56.42 1024 x 640 640 x 400
CGA70 640 x 400 31.47 70.09 1024 x 640 640 x 400
CGA84 640 x 400 37.86 84.13 1024 x 640 640 x 400
CGA85 640 x 400 37.86 85.08 1024 x 640 640 x 400
VGA60 640 x 480 31.47 59.94 1024 x 768 640 x 480
VGA72 640 x 480 37.86 72.81 1024 x 768 640 x 480
VGA75 640 x 480 37.50 75.00 1024 x 768 640 x 480
VGA85 640 x 480 43.27 85.01 1024 x 768 640 x 480
SVGA56 800 x 600 35.16 56.25 1024 x 768 800 x 600
SVGA60 800 x 600 37.88 60.32 1024 x 768 800 x 600
SVGA72 800 x 600 48.08 72.19 1024 x 768 800 x 600
SVGA75 800 x 600 46.88 75.00 1024 x 768 800 x 600
SVGA85 800 x 600 53.67 85.06 1024 x 768 800 x 600
XGA43i 1024 x 768 35.52 86.96 1024 x 768 1024 x 768
XGA60 1024 x 768 48.36 60.00 1024 x 768 1024 x 768
XGA70 1024 x 768 56.48 70.07 1024 x 768 1024 x 768
XGA75 1024 x 768 60.02 75.03 1024 x 768 1024 x 768
XGA85 1024 x 768 68.68 85.00 1024 x 768 1024 x 768
SXGA70a 1152 x 864 63.85 70.01 1024 x 768 1024 x 768
SXGA75a 1152 x 864 67.50 75.00 1024 x 768 1024 x 768
SXGA85a 1152 x 864 77.49 85.06 1024 x 768 1024 x 768
SXGA60a 1280 x 960 60.00 60.00 1024 x 768 1024 x 768
SXGA75a 1280 x 960 75.00 75.00 1024 x 768 1024 x 768
SXGA43i 1280 x 1024 46.43 86.87 960 x 768 1024 x 768
SXGA60 1280 x 1024 63.98 60.02 960 x 768 1024 x 768
SXGA75 1280 x 1024 79.88 74.94 960 x 768 1024 x 768
SXGA85 1280 x 1024 91.15 85.02 960 x 768 –
UXGA48i 1600 x 1200 62.50 96.08 1024 x 768 –
UXGA60 1600 x 1200 75.00 60.00 1024 x 768 –
UXGA65 1600 x 1200 81.25 65.00 1024 x 768 –
UXGA70 1600 x 1200 87.50 70.00 1024 x 768 –
UXGA75 1600 x 1200 93.75 75.00 1024 x 768 –
UXGA80 1600 x 1200 100.00 80.00 1024 x 768 –
UXGA85 1600 x 1200 106.25 85.00 1024 x 768 –
MAC13 640 x 480 35.00 66.67 1024 x 768 640 x 480
MAC16 832 x 624 49.72 74.55 1024 x 768 832 x 624
MAC19 1024 x 768 60.15 74.91 1024 x 768 1024 x 768
MAC21 1152 x 870 68.59 74.96 1024 x 768 1024 x 768
HP75 1024 x 768 62.94 74.92 1024 x 768 1024 x 768
HP72 1280 x 1024 78.13 72.00 960 x 768 1024 x 768
SUN66a 1152 x 900 61.85 66.00 984 x 768 1024 x 768
SUN76a 1152 x 900 71.81 76.64 984 x 768 1024 x 768
SUN66 1280 x 1024 71.68 66.68 960 x 768 1024 x 768
SUN76 1280 x 1024 81.13 76.11 960 x 768 1024 x 768
SGI72 1280 x 1024 76.92 72.30 960 x 768 1024 x 768
SGI76 1280 x 1024 82.00 76.00 960 x 768 1024 x 768
IBM60 1280 x 1024 63.42 60.00 960 x 768 1024 x 768

• *1 : As a result of line reduction in the projection
process with the computer models listed above,
lines and portions of characters found in the
original data may be missing from the projected
image.

• When the ZOOM MODE of PinP/EXPAND menu is
set to 4, by pressing the EXPAND button on the re-
mote control, it will switch to the screen displaying
the picture as its original size (real screen display).
In the real screen display, pictures will be black-
framed when picture resolution is lower than 1,024
x 768.

Important:
• Some computers may not be compatible with the

projector.
• The projector's maximum resolution is 1,024 × 768

pixel.  It may not be displayed correctly for the pic-
tures of higher resolutions than 1,024 × 768.

• The picture with a SYNC on G (Green) signal
may vibrate.

• The picture with a SYNC on G (Green) signal may
be tinged with green.

*1
*1
*1
*1
*1
*1
*1
*1
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GAMMA CORRECTION menu
The proportion of the brightness of input signals to that of output signals can be corrected effectively by adjusting
GAMMA.

1. Select  GAMMA CORRECTION of PICTURE menu
and then press the ENTER button. (The GAMMA
CORRECTION menu appears on-screen display.)

Horizontal axis: brightness of the input signals
Vertical axis: brightness of the output signals
Inclination: GAMMA

2. Press the  or buttons on the control panel (or
$ or % buttons on the remote control) to select
MASTER.

3. Press the  or buttons on the control panel (or
$ or % buttons on the remote control) to select the
points brightness of the input signals.

4. Press the ª or º buttons on the control panel (or
{ or } buttons on the remote control) to adjust
the brightness of the output signals.

5. Repeat steps 3 and 4 for another point setting.

GAMMA CORRECTION - USER

MASTER

R

G

B

RETURN100 20 30 40 50 60 70 80 90 100

GAMMA CORRECTION - USER

MASTER

R

G

B

RETURN100 20 30 40 50 60 70 80 90 100

GAMMA CORRECTION - USER

MASTER

R

G

B

RETURN100 20 30 40 50 60 70 80 90 100

GAMMA CORRECTION - USER

MASTER

R

G

B

RETURN100 20 30 40 50 60 70 80 90 100

If you wish to change the color balance, follow the steps
below.

6. Press the  or buttons on the control panel (or
$ or % buttons on the remote control) to select
MASTER, and then press the ª or º buttons on
the control panel (or { or } buttons on the remote
control) to select the desired color R, G or B.

7. Press the  or buttons on the control panel (or
$ or % buttons on the remote control) to select the
points brightness of the input signals.

8. Press the ª or º buttons on the control panel (or
{ or } buttons on the remote control) to adjust
the brightness of the output signals.

9. Repeat steps 7 and 8 for another point setting.

10. Press the ENTER button.

11. Exit the menu system by pressing the MENU but-
ton several times.

• To switch back to the default condition of GAMMA
CORRECTION, select RESET and press the EN-
TER button when the GAMMA CORRECTION dis-
play appears.

• When selecting RESET, the buttons cannot be oper-
ated for 2 to 18 seconds.

GAMMA CORRECTION - USER

MASTER

R

G

B

RETURN100 20 30 40 50 60 70 80 90 100

GAMMA CORRECTION - USER

MASTER

R

G

B

RETURN100 20 30 40 50 60 70 80 90 100

GAMMA CORRECTION - USER

MASTER

R

G

B

RETURN100 20 30 40 50 60 70 80 90 100

Picture adjustment (continue)
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Advanced feature for presentation
Cursor operation
1. Press the CURSOR button.

The cursor appears on the screen.

2. Press the START/STOP button to ON.
The operation indicator will be illuminated.
(The operation indicator will turn off if the remote
control is not used for a period of five minutes.)

3. Move the cursor by using the remote control.

4. Press the START/STOP button to momentarily
freeze the cursor movement. Press again to resume
moving.

5. Press the CURSOR button to cause the cursor to
disappear.

• When using the EXPAND mode, a red frame will
not appear if the cursor is selected.

To change the cursor size or the cursor moving
speed
1. Press the CURSOR button.

The cursor appears on the screen.

2. Press the START/STOP button to ON.
The operation indicator will be illuminated.

3. Press the DOUBLE CLICK button.
The tool icon appear on the screen.

To draw line or frame
1. Press the CURSOR button.

The cursor appears on the screen.

2. Press the START/STOP button to ON.
The operation indicator will be illuminated.

3. Press the DOUBLE CLICK button.
The tool icon appear on the screen.

4. Move the cursor to where the point of form icon.

5. Press the SELECT button until the desired form is
appeared.

6. Move the cursor to where the point of Width icon.

7. Press the SELECT button until the desired width
of the line is appeared.

8. Move the cursor to where the point of Color icon.

9. Press the SELECT button until the desired color of
the line is appeared. (Red, Yellow, Green, Blue,
Purple, Black or White)

10. Press the DOUBLE CLICK button.

11. Position the cursor where you want the path to be-
gin and press the SELECT button.
A red frame appears on the screen..
• The red frame will be disappeared by pressing

the CANCEL button.

12. Move the cursor to where you want the point of the
opposite corner and press the SELECT button again.

• By pressing the CANCEL button, the line or frame
will disappear.

• When the MENU appears, the cursor will disappear.
• When the cursor appears, the source ID will disappear.
• You can not adjust the zoom/focus in the cursor op-

eration mode.
• When using the EXPAND mode, a red frame will

not appear if the cursor is selected.
• The currently projected image will disappear in

the following cases: when PC card images are
updated, when alternating PinP or EXPAND
mode, or when display size is enlarged or
otherwise altered.

Still
How to stop the picture temporaly (still picture)
1. Press the ENTER/STILL button on the remote

control.
The picture will stop temporaly.

To stop still picture.
2. Press the ENTER/STILL button on the remote

control again.
• To release the still picture, Cursor, SELECT,

DOUBLE CLICK, CANCEL, and START/STOP
buttons also can be used.

SLOWFAST

4. Move the cursor to where the point of cursor size
icon.

5. Press the SELECT button until the desired size is
appeared.

6. Move the cursor to where the point of cursor speed
icon.

7. Press the SELECT button until the desired speed
is appeared.

8. Press the DOUBLE CLICK button.

Cursor size
Color

Width
Form

Cursor speed

Straight line 

Square

Rounded-square

Circle

Horizontal straight line 

Move
upward

Move
downward

Move to
right

Move to
left
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Advanced feature for presentation (Continue)

Expand
By pressing the EXPAND button on the remote con-
trol, you can view the detailed image of the picture.

Setting the Expand mode
1. Press the MENU button once to display the on-

screen menu.

2. Press the  or buttons on the control panel (or
$ or % buttons on the remote control) to select
PinP/EXPAND.

3. Press the ª or º buttons on the control panel (or
{ or } buttons on the remote control).

4. Press the  or buttons on the control panel (or
$ or % buttons on the remote control) to select
ZOOM MODE, POSITION or SIZE.

5. Press the ª or º buttons on the control panel (or
{ or } buttons on the remote control) to set the
ZOOM MODE, POSITION or SIZE.

Normal picture

Actual size picture

Zooming picture

(ZOOM MODE1)

(ZOOM MODE4)

Zooming picture

(ZOOM MODE3)

(ZOOM MODE2)

ZOOM MODE

Zooming picture

Normal 
picture

6. Press the MENU button twice to exit the menu sys-
tem.

Using the Expand mode
1. Press the EXPAND button.

A red frame indicating EXPAND area will appear.
• You can magnify different areas of the active pic-

ture by pressing the  ª , º,  or buttons on
the control panel (or {, }, $ or % buttons on the
remote control).

• You can change the magnification of the zoomed
area by pressing the + or - buttons.

2. Press the EXPAND button again.

• In EXPAND mode, do not display the test pattern.
• In EXPAND mode (except in type 4 mode) you can-

not adjust the zoom/focus.
• Display enlargement does not work with video

input or S-video input.
• The red frame indicating EXPAND area will

disappear when the cursor is selected.
Indication Mode 4 (actual size display)
• Pressing the  ª , º, , buttons on the

control panel (or { , } ,$, % buttons on the
remote control) is for adjusting fine adjust, zoom
or focus.

• The expanding rate cannnot be changed either
pressing + or - button.

Super impose (Picture in Picture)
One of the special features of this unit is the picture-
in-picture (PinP) mode. PinP allows you to view differ-
ent sources at the same time. The sub image will be-
come a still picture.

1. Press the PinP button on the remote control.
• Pressing the PinP button repeatedly will select

on and off.

2. Select the desired external input source of the sub
image by using the RGB, VIDEO or CARD button.
• You can change the frame position and the frame

size by using the on-screen menu.

To recapture the picture of sub screen
3 Press the –  or + button.

• By each press of the button will recapture the
picture of  sub screen.

To switch Main image and sub image
4 Press the  or buttons on the control panel (or

$ or % buttons on the remote control).

To switch still picture and playback picture between
Main image and Sub image
5 Press the ª or º buttons on the control panel

(or { or } buttons on the remote control) .

6. Press the PinP button on the remote control.
The sub image will be disappear.

• In PinP mode, the sub image will become still
pictures.  When the main image is set to PC1 or
PC2, the  sub image will become moving pictures.

• In PinP mode, the sound of the moving pictures will
be heard.

• The sub image may vibrate. If this is the case, select
the image again by pressing the ‘-’ button.

• In PinP mode you cannot adjust the zoom/focus.
• Ajusting contrast, brightness, tint or color isn't

available in PinP mode.
• To use different PC card (PC card 1, PC card 2) on

both Main image and Sub image is not available.
• When the main and sub images are set to PC1 or

PC2, images can be selected only from the same
group of the same PC-CARD.

• By setting the AUTO PIP on the PinP/EXPAND
menu to ON, the position of the sub image will
move automatically when the red frame indicating
the EXPAND area overlap with the sub image.
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PC-CARD
The projector can play back an image by using the PC-
CARD.

Using the PC-CARD
Use only the flash memory card of PCMCIA•ATA com-
patible type II.
• Due to PC-CARD type, some images can not be prop-

erly recorded.  Please contact your dealer.

Setting up the PC-CARD
1. Set the projector into standby mode by pressing the

main power switch. The POWER indicator lights up
red.

2. Open PC-CARD cover on the left side of the projec-
tor.

3. Make sure the PC card is going to be inserted in
right side.  The PC card
indicator of the PC card
which has been inserted
will illuminate.

4. Close the cover.

When the input source is set to
PC1 or PC2, or during recording to the PC card, do not
remove the PC card. The projector may not work cor-
rectly.

Release the PC-CARD
1. Press the RELEASE button on the remote control.

PC card eject icon will be displayed on the right
end of the screen.
The PC card indicator will turned off on the
projector.

2. Open PC-CARD cover on the left side of the projec-
tor.

3. Press the eject button to take the card out.

4. Close the cover.

• Upon removing a PC card, wait at least 2 seconds
before inserting another.

• When the input source is set to PC1 or PC2, or
during recording to the PC card, do not remove
the PC card. The projector may not work correctly.

• When having an access of PC card, PC card eject
prohibit icon will be displayed on the right end of
the screen.

• If you do not wish this icon to be indicated, turn
ICON on PC CARD menu to OFF.  In this case,
the icon appears when the RELEASE button is
pressed even the setting is OFF.

• PC card eject icon will be indicated till the card is
ejected. If you press the RELEASE button when
PC cards are inserted, you need to either take
both out or change one of the cards to the icon to
disappear.

• PC-CARD of the following manufacturers has been
confirmed of operation;
EPSON, TDK, Logitec, Panasonic, Verbatim, I-O
DATA.

Play back
1. Insert the prerecorded PC-card.

2. Press the CARD button repeatedly until PC-1 (or
PC-2) appear on the screen.

The PC-CARD index display appears on the screen.

3. Press the  or buttons on the control panel (or
$ or % buttons on the remote control) to select the
desired image.
• If the PC-CARD is recorded by using the per-

sonal computer, select the desired group by press-
ing the + or - button.

4. Press the ª or º button on the control panel (or
{ or } button on the remote control) to enter the
image display mode.

5. Press the  or buttons on the control panel (or
$ or % buttons on the remote control) to display
another image.

6. Press the VIDEO or RGB buttons to quit the PC-
CARD playback function.

7. Press the RELEASE button on the remote
control.

8. Press the eject button to take the card out.

• During PC-CARD playback, the sound is switched
off.

•  Noise may occur momentarily when images are
updated via PC card.

• The images recorded in BMP (not compressed)
will take a long time to playback.

• It takes about 10 seconds to playback JPEG
compressed data.

• When having an access of PC card as you want to
exchage images on PC card, there will be four red
line indicated at the edge of the screen.

• When the main and sub images are set to PC1 or
PC2, images can be selected only from the same
group of the same PC-CARD. Other group or other
card will not be able to indicate simultaneously.

• If the PC card is ejected when playing back PC
card, the image will be switched to Video 1 picture
automatically.

• During PC-CARD playback, if the incorrect
display appears, release and re-insert the PC-
CARD.

Playback picture taken by the digital camera
• The image which has been recorded in PCMCIA/

ATA card, smart media or compact flash can be
playback.  The PC card adapter is required to
playback smart media and compact flash.

• Depending on the type of the digital camera,
picture will not appear correctly.  Please contact
your dealer.

• PC card recorded by Digital Camera, the picture
will not be diaplayed on PC-CARD index display.
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PC-CARD (Continue)

To automatically change the image, follow the steps
as shown below.
1. Press the MENU button.

2. Press the  or buttons on the control panel (or

$ or % buttons on the remote control) to select PC
CARD AUTO PLAY.

3. Press the ª or º buttons on the control panel (or
{ or } buttons on the remote control).

4. Press the  or buttons on the control panel (or

$ or % buttons on the remote control) to select
AUTO SLIDE TIME.

5. Press the ª or º buttons on the control panel (or
{ or } buttons on the remote control) to set the
time for auto playback.

6. Press the  or buttons on the control panel (or

$ or % buttons on the remote control) to select
REPEAT.

7. Press the ª or º buttons on the control panel (or
{ or } buttons on the remote control) to select ON
or OFF.

8. Press the MENU button twice to exit the menu sys-
tem.

9. Press the CARD button repeatedly until PC-1 (or
PC-2) appear on the screen.

10. Press the  or buttons  on the control panel (or

$ or % buttons on the remote control) to select the
desired image.

PC CARD
AUTO PLAY

PinP/
EXPANDPICTURESIGNAL

PC CARD
AUTO PLAY

PinP/
EXPANDPICTURESIGNAL

33 sec.
ON

OFF

ON

OFF

REPEATAUTO SLIDE
TIME ICON

INSTALLATIONAUDIOPC CARD
AUTO PLAY

PinP/
EXPANDPICTURESIGNAL

 10 sec.
ON

OFF

ON

OFF

REPEATAUTO SLIDE
TIME ICON

INSTALLATIONAUDIOPC CARD
AUTO PLAY

PinP/
EXPANDPICTURESIGNAL

 30 sec.
ON

OFF

ON

OFF

REPEATAUTO SLIDE
TIME ICON

INSTALLATIONAUDIOPC CARD
AUTO PLAY

PinP/
EXPANDPICTURESIGNAL

 30 sec.
ON

OFF

ON

OFF

REPEATAUTO SLIDE
TIME ICON

INSTALLATIONAUDIOPC CARD
AUTO PLAY

PinP/
EXPANDPICTURESIGNAL

 30 sec.
ON

OFF

ON

OFF

REPEATAUTO SLIDE
TIME ICON

INSTALLATIONAUDIOPC CARD
AUTO PLAY

PinP/
EXPANDPICTURESIGNAL

11. Press the AUTO PLAY button on the remote con-
trol.
The image automatically changes according your
setting.

12. Press the AUTO PLAY button on the remote con-
trol to quit the PC-CARD automatic playback func-
tion.

•  A gray frame will appear during auto play.
•  Button operation will only work when the gray

frame appears on screen. Button operation is not
possible while the red frame is on-screen.

•  When projecting images in 2-screen display mode,
the screen will momentarily go black when images
inputted via PC card are updated.

•  Auto play can be stopped by pressing any button
(including SELECT, DOUBLE CLICK, CANCEL,
and START/STOP).

•  Auto play cannot be used either during image
enlargement or when menus are displayed.
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Advanced feature with PC
There are three types of application software provided.
1. PCV (PC Card Viewer)
2. PCGC (Personal Computer Graphic Controller)
3. SpacePointer (Driver for PC control by the remote

controller)
Environment
The following system software and hardware are nec-
essary to use the projector.

When you use Macintosh
• Macintosh series loading more than 68030 in

CPU and a video card with which more than
256 colors are available

• System7.1 or newer
• 8MB of Random-access memory (RAM) space

When you use Microsoft® Windows®

• Microsoft® Windows® 95 Operating System
(Windows 95) or Microsoft® Windows NT®

Operating System Version 4.0 (Windows NT) or
Microsoft® Windows® Operating System
Version 3.1 (Windows 3.1)  with the CPU
loading more than 80486SX and a display card
with more than 256 colors are available

• 16MB or more of RAM available
• We recommends the following hardware.

• 32MB or more of RAM available
• A video display card with full colors are

available

EXPORT LAW ASSURANCES
You acknowledge and agree that the SOFTWARE is subject
to restrictions and controls imposed by the United States
Export Administration Act (the “Act”) and the regulations
thereunder. You agree and certify that neither the
SOFTWARE nor any direct product thereof is being or will
be acquired, shipped, transferred or reexported, directly or
indirectly, into any country prohibited by the Act and the
regulations thereunder or will be used for any purpose
prohibited by the same.

LIMITATIONS OF REMEDIES
Regardless of whether any remedy set forth herein fails of
its essential purpose, in no event will Mitsubishi be liable
to you for any special, consequential, indirect or similar
damages, including any lost profits or lost data arising out
of the use or inability to use the SOFTWARE or any data
supplied therewith even if Mitsubishi or anyone else has
been advised of the possibility of such damages, or for any
claim by any other party.
Some states do not allow the limitation or exclusion of
liability for incidental or consequential damages so the
above limitation or exclusion may not apply to you.
In no case shall Mitsubishi’s liability exceed the price for

the SOFTWARE.

A. PCV (PC Card Viewer)
PC-CARD viewer (PCV) is a utility software that lets
you record and project an  image to a PC-CARD by us-
ing a personal computer.

Installation of software
For Windows 95 or Windows NT
1.  Start up Windows.

2. Insert the Projector driver CD-ROM into your CD-
ROM drive.

3. Start up Program Manager.
Click the [Start] button and select the [Run (R)] com-
mand. Then the [Run] dialog box is displayed.

4. If you inserted the CD-ROM to drive D, type [D:
Win95\Pcv\Us\Setup95] (Windows 95) or [D:
Winnt40\Pcv\Us\Setupnt] (Windows NT) in the
"command line" text box and click the "OK" button.
The letter [D] may be different according to the
drive you use.

5. When the setup program starts up, follow the on-
screen instructions.

6. When the message “Completed” appears on screen,
click the [Finish] button to complete the installation.

• Installation of Microsoft Internet Explorer 3.02 (or
later) is required for optimum unit operation. Use
the Jaaxdist.exe command should the unit appear
to not be performing normally.

For  Windows 3.1
1.  Start up Windows.

2. Insert the Projector driver CD-ROM into your CD-
ROM drive.

3. Select the [Run (R)] command on the icon menu so
that the dialog box [Run] is displayed.

4. If you inserted the CD-ROM to drive D, type
[D:Win31\Pcv\Us\Setup] in the "command line"
text box and click the "OK" button. The letter [D]
may be different according to the drive you use.

5. When the setup program starts up, follow the on-
screen instructions.

6. When the message “completed” appears on screen,
click the [OK] button to complete the installation.

For Macintosh
1. Start up Macintosh.

2. Insert the Projector driver CD-ROM into your CD-
ROM drive.

3. Copy "PCV for Mac” file in the “PCV” folder to
anywhere on the hard disk.
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Advanced feature with PC (Continue)

Starting up PCV (For Windows)
For Windows 95 or Windows NT
1. Start up Windows.

2. Insert the PC card to the PC Card slot on the per-
sonal computer.

3. Start up Program Manager.
Click the [Start] button and select the [Program
(P)]➔ [Pcv]➔ [PCV]command.

For Windows 3.1
1. Start up Windows.

2. Insert the PC card to the PC Card slot on the per-
sonal computer.

3. Double click the [PCV] icon in the PCV folder.

Command reference (For Windows 95)
The command references are as shown below:
File

New presentation .... Create a new presentation.
Open presentation... Opens an existing presenta-

tion.
Close presentation ... Closes an opened presenta-

tion.
Save presentation .... Saves an opened presentation

using the same name.
Save presentation As... Saves an opened presentation

to a specified name.
Delete presentation . Delete an opened presenta-

tion.
Exit ........................... Exits PCV.

Edit
Cut ............................ Deletes selected image from

the presentation and moves it
to the clipboard.

Copy .......................... Copies selected image data
from the presentation to the
clipboard.

Paste ......................... Pastesimage data from the clip-
board into the presentation.

Image
Add image

Image file... ......... Inserts image file to an opened
presentation.

Screen capture... . Captures screen and inserts it
to an opened presentation.

Delete image... ......... Deletes the selected image
from an opened presentation.

Image information... Displays information of the
selected image.

View
Tool Bar .................... Shows or hides the toolbar.
Drive Bar .................. Shows or hides the drivebar.
Status Bar ................ Shows or hides the status bar.

Window
Cascade .................... Arranges windows in an over-

lapped fashion.
Tile Horizontal ......... Arranges windows in non-

overlapped horizontal tiles.
Tile Vertical .............. Arrages windows in non-over-

lapped vertical tiles.
Arrange Icons ........... Arranges icons of closed win-

dows.
Windows 1, 2, ... ....... Goes to specified window.

Help

Help Topics ............... Offers you an index to topics
on which you can get help.

Advanced settings .... Displays a detail setting of
this application.

About PCV... ............. Displays the version informa-
tion of this application.

Command reference (For Windows 3.1)
The command references are as shown below:
File

New presentation .... Create a new presentation.
Open presentation... Opens an existing presenta-

tion.
Close presentation... Closes an opened presenta-

tion.
Save presentation... . Saves an opened presentation

using the same name.
Delete presentation...Delete an opened presentation.
Open image file... ..... Import an image from a file.
Exit ........................... Exits PCV.

Edit
Cut ............................ Deletes selected image from

the presentation and moves it
to the clipboard.

Copy .......................... Copies selected image data
from the presentation to the
clipboard.

Paste ......................... Pastesimage data from the
clipboard into the presenta-
tion.

Tool
Capture .................... Captures screen and inserts it

to an opened presentation.
Delete image... ......... Deletes the selected image

from an opened presentation.
View

Tool Bar .................... Shows or hides the toolbar.
Status Bar ................ Shows or hides the status bar.

Option
Select card drive... ... Select (or change) the PC-

CARD drive.
Card drive info... ...... Display the information of the

selected PC-CARD drive.
Index image size... ... Select the size of index image.

Help
About PCV... ............. Displays the version informa-

tion of this application.
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Recording the image (For Windows)
When you wish to record the image of the display to a
PC-CARD.

1. Cooose the PC-CARD drive using the drive bar
under the status bar.

9. Click the return button.
The presentation window will open. The recorded
image appears on the presentation window.

• Depending on the personal computer, the recorded
image can appear incorrectly. In this case, set the
delay time longer by using the Capture setting
dialog box.

10. Choose [Save presentation...] under the [File]
menu.
• A presentetion which has been recorded

already, Select “Save As...” to asve as.

11. Choose [Exit] under the [File] menu to quit from
PCV.

When you wish to record the image from existing files.

1. Cooose the PC-CARD drive using the drive bar
under the status bar.
• If you are using Windows 3.1, select ‘Select card

drive‘ in Option menu of PCV main wimdow.

2. Choose [New presentation...] under the [File]
menu.
The new presentation window will open.

3. Choose [Add image] under the [Image] menu and
then choose [Image file...].
• If you are using Windows 3.1, select ‘Open

image file‘ in File menu of PCV main wimdow.

4. Select the image you wish to record.

5. Click OK button.
The recorded image appears on the presentation
window.

• The maximum number of group (presentation)
that can be recorded to a PC card is 160.

• The maximum number of the images that can be
recorded to a group is 99.

6. Repeat steps 3 to 5 for other images.
7. Choose [Save presentation...] under the [File]

menu.
8. Choose [Exit] under the [File] menu to quit from

PCV.

Drive bar

• If you are using Windows 3.1, select ‘Select card
drive‘ in Option menu of PCV main wimdow.

2. Choose [New presentation...] under the [File]
menu.
The new presentation window will open.

3. Choose [Add image] under the [Image] menu and
then choose [Screen capture...].
• The PCV windows disappear and the capture

dialog box appears.

Capture setting buttton
Return button

Capture button

• If you are using Windows 3.1, select ‘Image
capture...‘ in TOOL of PCV main wimdow.

4. Display the image you wish to record on the
screen.

5. Click the capture button.
The Compress setting window appears.

6. Select the compress type.
• You can confirm the compressed image by

clicking the Preview button.
• If the command [Preserving the setting] is

checked , you don’t need to set the style of save
by each images (Not Windows 3.1).

7. Click OK button.

8. Repeat steps 4 to 7 for other images.
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Editing the presentation (For Windows)
Delete the image
1. Select the image to be deleted.

2. Choose [Delete image...] under the [File] menu.
• If you are using Windows 3.1, choose [Delete

image] under the [Option] menu.

Sequencing
A. Exchange images
You can exchange the images among images next to
each other.
1. Select an image to be exchanged.

2. Drag the image and drop on the next or previous
image.

Advanced feature with PC (Continue)

Preview an image
1. Double click the image.

The preview image appears on the displays.

{

B. Move images
You can move images to another position.
1. Select an image to be moved.

2. Drag the image and drop it on the other image
(except next or previous image).
The image will be moved to the previous position
of the dropped image.

{

2. Choose OK to close the image information window.

How to save a file which has been made
by a presentation software (For
Windows 95 only)
1. Make up a presentation by the presentation

software.

2. Choose [Print] under the [File] menu.

3. Set to PCV driver for printing name.

• PCV drive will automatically be installed in
the system of the personal computer when PCV
is installed.

2. Click the image by using the left button of the
mouse.

Display image information
1. Choose [Image information] under the [Image]

menu.
The image information window appears.
• If you are using Windows 3.1, choose click the

image by using the right button of the mouse.
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4. Click the properties button. Starting up PCV (For Macintosh)
1. Start up Macintosh.

2. Insert the PC card to the PC Card slot on the per-
sonal computer.

3. Double click the [PCV for Mac] icon.

Command reference
The command references are as shown below:
File

Create New presentation . Create a new presentation.
Open presentation... Opens an existing presenta-

tion.
Close presentation ... Closes an opened presenta-

tion.
Save presentation .... Saves an opened presentation

using the same name.
Delete presentation . Delete an opened presenta-

tion.
Open image file... ..... Import an image from a file.
Done ......................... Exits PCV.

Edit
Cut ............................ Deletes selected image from

the presentation and moves it
to the clipboard.

Copy .......................... Copies selected image data
from the presentation to the
clipboard.

Paste ......................... Pastesimage data from the
clipboard into the presenta-
tion.

Clear... ...................... Deletes the selected image
from an opened presentation.

Option
Preference... ............. Select the format BMP or

JPEG.
Get Screen Shot Image .... Captures screen and inserts it

to a presentation.

Recording the image (For Macintosh)
When you wish to record the image of the display to a
PC-CARD.

1. Display the image you wish to record on the screen.

2. Press the shift button, command button and
number 3 button simultaneously.

3. Repeat steps 1 and 2 for other images.

4. Choose [GetScreen Shot Image] under the [Op-
tion] menu.
The presentation window will open. The recorded
image appears on the presentation window.

• The file type to be recorded are BMP or JPEG. To
change file type, select [Preference] under the
[Option] menu then change setting. Reboot PCV.

5. Choose [Save presentation...] under the [File] menu.

6. Choose [Done] under the [File] menu to quit from
PCV.

5. If necessary, set the Resolution, Expand, File
Format or JPEG Quality.

6. Click OK button on the PCV driver Properties
dialog box.

7. Click OK button.

8. Cooose the PC-CARD drive.

9. Click OK button.
• The presentation data will be saved as PCVdrv

on PC card.
• PCVdrv is a temporaly file. If you record

presentation continuously ,The previous data
will be erased. Please follow as below to re-
name the file.

10. Boot up PCV’s programme.

11. Choose [Open presentation...] under the [File]
menu.

12. Select PCVdrv file

The presentation window will openand.  The
recorded image appears on the presentation
window.

13. Choose [Save presentation As...] under the [File]
menu.

14. Choose [Exit] under the [File] menu to quit from
PCV.
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When you wish to record the image from existing files.

1. Choose [Create New presentation...] under the
[File] menu.
The new presentation window will open.

2. Choose [Open image file] under the [File] menu.

3. Select the image you wish to record.

4. Click OK button.
The recorded image appears on the presentation
window.

5. Choose [Save presentation...] under the [File]
menu.

6. Choose [Done] under the [File] menu to quit from
PCV.

Editing the presentation (For Macintosh)
Delete the image
1. Select the image to be deleted.

2. Choose [Clear] under the [File] menu.

Sequencing
A. Exchange images
You can exchange the images among images next to
each other.
1. Select an image to be exchanged.

2. Drag the image and drop on the next or previous
image.

Advanced feature with PC (Continue)

B. Move images
You can move images to another position.
1. Select an image to be moved.

2. Drag the image and drop it on the other image
(except next or previous image).
The image will be moved to the previous position
of the dropped image.

{

Preview an image
1. Select an image to be previewed.

2. Double click the image.
The preview image appears on the displays.

{
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B. PCGC (Personal Computer Graphic Control)
By connecting to personal computer is RS-232C port, you can operate your computer with the projector remote
control. Also you can set the menu setting of the projector by computer.
Connection

Projector + IBM PC or IBM PC compatibles (DOS/V)

Note: If the only serial port is a “modem/printer”, use it.

Projector + NEC PC 98 and EPSON series

RS-232C cable
to Com1 
Comport

to RS-232C 1
IN terminal

Note: If your PC (IBM or IBM compatible) is equipped only with a 25-pin serial port connector,
a 25-pin serial port adapter is required. Contact your dealer for details.

RS-232C cable RS-232C adapter 
for Macintosh

to modem port
or printer port 

to RS-232C 1
IN terminal

Projector + Macintosh

RS-232C cable RS-232C
adapter for NEC
(option)

to RS-232C terminal

to RS-232C 1
IN terminal
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Installation of software
For Windows 95
1.  Start up Windows.

2. Insert the Projector driver CD-ROM into your CD-
ROM drive.

3. Start up Program Manager.
Click the [Start] button and select the [Run (R)] com-
mand. Then the [Run] dialog box is displayed.

4. If you inserted the CD-ROM to drive D, type [D:
Win95\Pcgc\Us\Setup] in the "command line" text
box and click the "OK" button. The letter [D] may be
different according to the drive you use.

5. When the setup program starts up, follow the on-
screen instructions.

6. When the message “Completed” appears on screen,
click the [Finish] button to complete the installation.

For  Windows 3.1
1.  Start up Windows.

2. Insert the Projector driver CD-ROM into your CD-
ROM drive.

3. Select the [Run (R)] command on the icon menu so
that the dialog box [Run] is displayed.

4. If you inserted the CD-ROM to drive D, type
[D:Win31\Pcgc\Us\Setup] in the "command line"
text box and click the "OK" button. The letter [D]
may be different according to the drive you use.

5. When the setup program starts up, follow the on-
screen instructions.

6. When the message “completed” appears on screen,
click the [OK] button to complete the installation.

For Macintosh
1.  Start up Macintosh.

2. Insert the Projector driver CD-ROM into your CD-
ROM drive.

3.  Copy "PCGC” file in the “US” folder of the
“PCGC” folder to anywhere on the hard disk.

Starting up PCGC
Double click the [PCGC] icon in the setup folder to
start up PCGC.

• Do not use SpacePointer during the PCGC opera-
tion.

Note:
• When you operate the PCGC, do not use

SpacePointer.
• Make sure proper connection shave been made, or

else the PCGC will not start up.
• When you operate the PCGC, switch off the menu

display on the projector.
When you operate the PCGC, be sure not to press
any buttons on the control panel on the projector
(except the POWER button).

Caution:
• Mitsubishi is not responsible for any complica-

tions caused by the use of this PCGC software.
For improvement, Mitsubishi reserves the right to
change or alter any or all specification or design of
this remote control and the content of the owner's
guide without any prior notice.

• No part of this software and owner's guide may be
reproduced, transmitted, transcribed, stored in
a retrieval system, or translated into any lan-
guage in any form by any means. Otherwise, this
will be considered as a copyright infringement.

Advanced feature with PC (Continue)
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C. SpacePointer
The remote control provides remote PC operation for presentation from PC.

Connection

Projector + IBM PC or IBM PC compatibles (DOS/V)

RS-232C cable

RS-232Ccable(option)

to Com1
Comport

to RS-232C
1 terminal

to RS-232C
2 terminal

When connecting two personal computers 

to Com1
Comport

RS-232C adapter
for Macintosh

Note: If your PC (IBM or IBM compatible) is equipped only with a 25-pin serial port connector,
a 25-pin serial port adapter is required. Contact your dealer for details.

Projector + Macintosh

to RS-232C
2 terminal

When connecting two personal computers 

RS-232C cable

Printer cable for Macintosh (option)

RS-232C adapter
for Macintosh

to modem port
or printer port

to modem port
or printer port

to RS-232C
1 terminal

Note: If the only serial port is a “modem/printer”, use it.

Projector + NEC PC 98 series

RS-232C adapter
for NEC (option)

RS-232C adapter
for NEC (option)

to RS-232C terminal
RS-232C cable

RS-232C cable (option)

to RS-232C
1 terminal

to RS-232C
2 terminal

When connecting two personal computers 

to RS-232C
terminal

RS-232C adapter
for Macintosh
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Installation of software
For Windows 95
1.  Start up Windows.

2. Insert the Projector driver CD-ROM into your CD-
ROM drive.

3. Start up Program Manager.
Click the [Start] button and select the [Run (R)] com-
mand. Then the [Run] dialog box is displayed.

4. If you inserted the CD-ROM to drive D, type [D:
Win95\Sp\Setup] in the "command line" text box
and click the "OK" button. The letter [D] may be
different according to the drive you use.

5. When the setup program starts up, follow the on-
screen instructions.

6. When the message “Completed” appears on screen,
click the [Finish] button to complete the installation.

For  Windows 3.1
1.  Start up Windows.

2. Insert the Projector driver CD-ROM into your CD-
ROM drive.

3. Select the [Run (R)] command on the icon menu so
that the dialog box [Run] is displayed.

4. If you inserted the CD-ROM to drive D, type
[D:Win31\Sp\install] in the "command line" text
box and click the "OK" button. The letter [D] may
be different according to the drive you use.

5. Select the [Installation (I)] commandon the instal-
lation menu.

6. When the setup program starts up, follow the on-
screen instructions.

7. When the message “completed” appears on screen,
click the [OK] button to complete the installation.

For Macintosh
1.  Start up Macintosh.

2. Insert the Projector driver CD-ROM into your CD-
ROM drive.

3.  Copy "Alps RSSPointer" file in the “US” folder of
the “SpacePointer” folder to the system folder.

4. Restart the Macintosh.

Operation of PC by remote control
The remote control provides remote PC operation for
presentation from PC.
1. Press the RGB button to select RGB1 or RGB2.

2. Press the START/STOP button to ON.
The operation indicator will be illuminated.

3. Confirm that the cursor of the projector does not
appear on the screen. If the cursor does appear, press
the CURSOR button to OFF.
You can use the SELECT, CANCEL and DOUBLE
CLICK button in the same way as the button on the
mouse. You can also move the cursor of PC by using
the remote control. For cursor moving, see page 25.

4. Press the START/STOP button to exit from PC
control mode.

• Depending on the personal computer, SpacePointer
may not work after leaving from the suspended
mode.  In this case, click the Apply button on the
control panel.  See below.

Setting of SpacePointer
For Windows
You can set the several settings in the SpacePointer
control panel in the control panel folder.
• Mouse cursor size and color cannot be adjusted in

the Windows 3.1.

Advanced feature with PC (Continue)

Tracking speed
If you click Fast, the cursor
moves more than twice as fast
as you move the space pointer.
When you first try the remote
control, set it to slow.

SpacePointer

SpacePointer®

Enable/Disable

SLOW

Change cursor

OK

FAST

Enable

ON

COM1 COM2 COM3 COM4

Disable

OFFReceiverCheck

ConnectPort

Cancel Apply Help

Port selection
Used to select the port connected
to the projector.

Size/color
Changes the size and color of the
mouse cursor.

Enable/Disable
For normal use set to Enable. If
you do not use SpacePointer, set
to Disable.

For Macintosh
You can set the several settings in the Alps RSSPointer
control panel in the control panel folder.

Port selection
Used to select the port connected
to the projector.

Alps RSSPointer

ALPS  SpacePointer
Monitor Size : Por t :

FastSlow

H

W
Modem

(W)                     (H)

1152         X        870

Tracking speed
If you click Fast, the cursor
moves more than twice as fast
as you move the space pointer.
When you first try the remote
control, set it to slow.

Monitor size

Help



39

E
N

G
L

IS
H

Uninstallation of software
For Windows 95
1.  Start up Windows.

2. Insert the Projector driver CD-ROM into your CD-
ROM drive.

3. Start up Program Manager.
Click the [Start] button and select the [Run (R)] com-
mand. Then the [Run] dialog box is displayed.

4. If you inserted the CD-ROM to drive D, type [D:
Win95\Sp\Spuninst] in the "command line" text
box and click the "OK" button. The letter [D] may be
different according to the drive you use.

5. When the installation program starts up, follow the
on-screen instructions.

6. When the message “Completed” appears on screen,
click the [Finish] button to complete the installation.

If  you use the  Windows 3.1
1.  Start up Windows.

2. Insert the Projector driver CD-ROM into your CD-
ROM drive.

3. Select the [Run (R)] command on the icon menu so
that the dialog box [Run] is displayed.

4. If you inserted the CD-ROM to drive D, type
[D:Win31\Sp\install] in the "command line" text
box and click the "OK" button. The letter [D] may
be different according to the drive you use.

5. Select the [Uninstallation (U)] commandon the in-
stallation menu.

6. When the setup program starts up, follow the on-
screen instructions.

7. When the message “completed” appears on screen,
click the [OK] button to complete the uninstallation.

For Macintosh
1. Start up Macintosh.

2. Move "Alps RSSPointer" in the control panel folder
in the system folder to “Trash”.

3. Restart the Macintosh.
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The light source lamp is designed to project the image
on the LCD panel. When the light source lamp no longer
functions, replace it with a new one to ensure optimum
performance.

Caution:
• Do not remove the light source lamp from inside of

this equipment immediately after using the projec-
tor, you may get burned because of the high tem-
perature of the light source lamp.

• When you replace the light source lamp, press the
power button to power off, then wait for 120 sec-
onds in stand-by mode to cool down the lamp and
LCD panels. Turn off  the main switch,  unplug the
power code from the outlet and wait one hour so
that the lamp is cool to the touch.

• Do not remove the light source lamp except for re-
placement. Careless treatment can cause injury or
fire.

• Do not touch the lamp directly. It may be broken
and may cause you to injure or burn yourself.

• Be sure not to drop the lamp lid screw into the pro-
jector. Also be sure also not to insert metal or any
flammable objects, it may cause fire or an electric
shock. If any objects are inserted, please unplug and
contact your dealer.

• Install the lamp securely, failure to do so it may
cause a fire.

1. Loosen the screw of
the lamp lid on the
top cover using a
screwdriver (+) , and
remove the lid.

• Remove the lamp
cover in the direc-
tion of the arrow as
indicated.

Important:
Be careful not to damage the electric wire connected
to this equipment.

2. Loosen a screw (a) of fix-
ing metal using a screw-
driver (+), and remove
them.
Do not lose the fixing
metal and screws.

Replacement of a light source lamp

(a)

(e)

Fixing
metal

3. Set Lamp exchanging metal into the projector.
1) Insert metal fittings for lamp replacement in

the following positions: on the front face of the
lamp (2 positions), between the lamp, and on
the bottom edges (4 positions).

2) Align screw holes (c) with node (d).
3) Fasten the piece into place using the two

screws included (b, b’).

Lamp exchange
metal

Hooks
(x 6)

4. Loosen the lamp fixing screw (e) using a screwdriver
(+), and remove it.

5. Hold onto the projector
by the handle as you pull
out the lamp.
For the lamp you have
removed, do not spill liq-
uid on it, place it near
flammable objects or
where children can touch
it.  Otherwise, it will cause in-
jury or fire.

6. Insert the new lamp securely
into the projector body in the
right direction.

7. Tight up the screws (e) which
have been removed in 4 using a screwdriver (+).

8. Loosen the two screws (f), (f')
of lamp exchanging metal
using a screwdriver, and re-
move them with the metal.

9. Remove the holes from the
lamp replacement metal
fittings (c) from the node
(d).

10. Insert the fixed metal pieces
from step 2 into the screw
holes (f) and (f ’), and use one
screw (a) to hold the piece in
place.

Lamp

Handle

(f')(f)

(e)

(a)

Loosen here

(c)
(b')

(b)

(d)

(e)
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Caution:
• The light source lamp is fragile. Be careful not to

cut yourself with the fragments.
• The lamp life depends on the environment. For re-

placement lamps, please contact your dealer.

The projector automatically shuts off when
the lamp is used up in about 1,300 hours
and not used until  lamp replacement.

11. Tighten up the screw of
the lamp lid using a
screwdriver (+).

How to reset the operation time meter
Plug in the power cord, switch on the projector and re-
set lamp time by pressing the ,  and POWER but-
tons simultaneously.

• Lamp cannot be removed from the projector unless
setting the lamp exchanging metal.

• If you do not have the lamp exchanging metal, re-
move the metal from the new lamp and use it.  Do
not touch the lamp directly.  It may be broken and
may cause you to injure or burn or yourself.

Caution:
• For the lamp you have removed, do not spill liquid

on it, place it near flammable objects or where chil-
dren can touch it. Otherwise, it will cause injury or
fire.

• Be sure that the projector guide is firmly inserted
between the right and left lamp guides.
Do not touch the lamp directly, place a cloth over
the replacement lamp.

Important:
• The projector will not turn on if you do not secure

the lamp lid.
• The operation time meter must be reset after the

lamp has been replaced.
• Do not reset the operation time meter unless the

lamp has been replaced.

The life of the lamp
The average life of the lamp for the projector is about
1,000 hours of consecutive use. Life span may differ
according to operating environment, and may be shorter
than 1000 hours. Decreases in luminescence and/or
color brightness will indicate that the light source lamp
is in need of replacement. When lamp operation time
exceeds 1,000 hours, the indicator will flash alternately
between green and red (while the lamp is in operation;
when the lamp is not in operation, the indicator will
appear red only).   When the lamp has been used for
about 1,250 hours, the message “LAMP!!.” will appear
on the screen. When the lamp has been used for about
1,300 hours, the projector will automatically shut off
for the safety of the lamp and the power indicator light
up in red. The projector cannot be used until the lamp
has been replaced.
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Maintenance
Caution:
Be sure to turn off the projector and unplug the power
cord from the wall outlet before you perform any main-
tenance on the projector.

Cleaning the air-filter
Clean the air-filter frequently. If the filter or ventila-
tion slots become clogged with dirt or dust, the tem-
perature inside of the projector may rise and shut of
the power (the thermal indicator starts to blink red).

1. Press and raise the air-filter cover with a screwdriver
(–).

2. Wash the air-filter.
Use water or a mild detergent diluted with water to
clean the filter. Rinse the filter thoroughly and let it
dry completely. If the filter is damaged or becomes
extremely dirty, contact your dealer for replacement
information.

3. Attach the air filter to the cover.

4. Reinstall the air-filter cover.

Note: The power will not turn on if the air-filter cover
is improperly installed.

Caution:
Be sure to use the projector with an air-filter. If not,
dust may get inside the projector, causing a fire or a
breakdown.

Cleaning the projector and the ventilation
slots
Use a soft cloth to clean the projector and the ventila-
tion slots. When the slots become dirty, wipe them with
a soft cloth dampened with a diluted mild detergent,
and then wipe them with a dry cloth.
To protect the surface of the projector from fading or
deteriorating:

• Do not spray insecticide on or inside the
projector.

• Do not use benzine or thinner to clean it.
• Do not let rubber or plastic materials come into

contact with the projector.

Cleaning  the lens
Use a standard lens-cleaning brush or a piece of lens
tissue dampened with lens cleaning fluid. The lens sur-
face is fragile. Use only recommended, nonabrasive
lens-cleaning materials. Do not touch the lens with your
fingers.

FILTER

FILTER COVER



43

E
N

G
L

IS
H

Troubleshooting
The following offers solutions to some of the common problems you may encounter. We suggest that you consult
this chart before contacting your dealer.

CAUSE

• The air intake vents, exhaust vents  or air filter
is clogged with dust or some object.

Power indicator does not light up.
• Power cord is unplugged from the outlet.
• Power cord is disconnected from the projector.
• The main switch is turned off.
• The lamp lid is open.
Power indicator blinks red.
• The projector has been turned on again too soon

after having been turned off.
• When the power switch was turned off while

the fan was running, during or after lamp
operation.

• The room temperature is too high.
(Does the lamp indicator show an unusual
condition?)

• Lamp is no longer working.
Power indicator blinks between red and green.
• The filter cover is not closed.
• When the power source lamp indicator or the

temperature indicator is either on or blinking,
the main unit requires repairs.

• Lens is covered by lens cap.
• When the power source lamp indicator or the

temperature indicator is either on or blinking,
the main unit requires repairs.

• The equipment connected to this projector is not
turned on.

• Hookup is not made correctly with other equipment.
• The input source is not selected correctly.

• The projector is not at a right angle to the screen.

• Brightness, tint and color are not adjusted cor-
rectly.

• The projecting distance is beyond the focused area.
• Lens is dirty.
• Screen size exceeds screen size specifications.
• Brightness, contrast and DLE are not adjusted

correctly.
• FINE adjustment is not made correctly.
• Tracking is not adjusted.
• The projector is not at a right angle to the screen.

• Remove the object.

• Plug the power cord into the outlet.
• Insert the power cord into the projector.
• Turn the main switch on.
• Close the lamp lid.

• Wait for the lighting sequence.

• Turn the power switch on and off several times.

• Refer to "Indicators" on page 44.

• Replace the lamp with a new one.

• Close the cover correctly.
• Contact your dealer.

• Take the lens cap off.
• Replace the lamp with a new one.

• Turn on the connected equipment.

• Confirm the hookup.
• Select the correct source according to the equip-

ment connected to this projector.

• Adjust the angle of the projector to make a right
angle to the screen. See page 11.

• Adjust brightness, tint and color correctly.

• Adjust the projecting distance. See page 10.
• Clean lens.
• Reduce screen size to within 40" to 300".
• Adjust brightness, contrast.

• Make FINE adjustment.
• Adjust tracking.
• Adjust the angle of the projector to make a

right angle to the screen. See page 11.

• When  you see the stationary image for a long time, it may remain on the screen if you change the
image. It is not a breakdown. The blurred image will disappear in a few minutes.

• It is normal.

• The cable for connection with other equipment
is not plugged securely into the terminal.

• The projector is installed too close to other
equipment.

• Volume is not turned up.
• Mute function on PCGC is on.
• Connection to other equipment is not made

correctly.

• The PC monitor is not turned on.

• This is typical of the LCD projector.

• The operation is incorrectly made due to noise or
interference.

• Plug the connecting cable securely into the
terminal. See pages 12-15.

• Install the projector far away from other
equipment.

• Turn up the volume.
• Cancel the mute function.  See page 20.
• Check connections.

See pages 12-15.

• Turn on the monitor.

• Press the MENU and POWER buttons simulta-
neously.  See page 18.

POSSIBLE SOLUTIONSPROBLEMS

The power is off.

No picture appears
on the screen.

The image is
distorted.

The image is dark.

The image is
blurred.

Red, blue or green dots
are viewed on the text of
image.

The image remains
blurred.

The image is
distorted on the
screen and noise is
heard.

No sound is heard.

Adjustments cannot be
made.

Warm air comes out of
the exhaust vents.

Nothing is displayed on
the PC monitor.
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Indicators
The projector has three indicators each of which shows the working condition of the projector.

The following offers solutions to possible problems. If a problem persists, turn the projector off and consult your
dealer.

LAMP

RGB VIDEO

TEMP

INDICATOR

TEMP
INDICATOR

SHOWS

blinking red

CONDITION
• Unusual temperature

Normal

Lamp is almost used up.

• Lamp is used up.

• The power is not turned on.
(Power indicator lights up red.)

Standby

Power-on

• The filter cover is not closed.
(When the TEMP indicator and
the LAMP indicator are off.)

• Abnormal
(When the TEMP indicator
or the LAMP indicator
steady on or blinking.)

Steady green

The power is turned off
and the POWER indicator
lights up red.

• The ventilation slots or air
filter is clogged with dust
or debris.

• The fan has stopped due
to an impediment.

• The location temperature
is too high.

• The filter is dirty.

POSSIBLE SOLUTIONS

• Remove the object from
the ventilation slot.

• Pull out the power
plug and remove the
object. If you cannot,
consult your dealer.

• Relocate the projector
to a cooler place.

• Clean the filter.

-

Replace the lamp.
Exchange with a new
lamp if the same
problem recurs.

-

-

LAMP
INDICATOR

Blinking red/green
or Blinking red

Steady red

Steady green

Steady red

Blinking red/green
or Blinking red

POWER
INDICATOR

• Close the cover cor-
rectly.

• Contact your dealer.
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Specifications

LCD projector

LVP-X200A

AC100 ~ 240V,  50 / 60Hz

5.0A

1.3-inch LCD panel: 3 pieces (for R, G, B)
Pixels 1,024 ×   768 = 786,432 pixels
Total   2,359,296 pixels

Active pixel rate: 99.99 % or more (each panel)

F 2.3~2.7     f = 53.3 ~ 69.3 mm

330 W DC metal halide lamp

aspect ratio 4:3 40~300 inch

1 W + 1 W stereo

6 cm round type (8Ω 1W) ×     2 pcs.

Luminance signal: 1.0 Vp-p 75Ω    (negative sync.)
Chroma signal: 0.286 Vp-p 75Ω  (burst signal)

1.0 Vp-p  75Ω   (negative sync.)

350 mVrms,  10kΩ or more

RGB: 0.7Vp-p  75Ω (positive sync.)
YCBCR: Y:1.0Vp-p (negative sync.) CBCR:0.7Vp-p
HD/CS : TTL level (positive)
VD : TTL level (positive)

Type

Model

Rated power supply

Rated input

LCD panels

Projection lens

Light source lamp

Picture size

Audio output

Speakers

S-video input

Video input

Audio inputs

Analog RGB input

     (mini D-SUB 15P)

PC audio inputs 350 mVrms,  10kΩ or more ø3.5mm stereo mini jack

Control connector
Serial (D-DUB 9 pin male connector) RS-232C standards
Serial (Mini DIN 8 pin female connector) RS-232C standards

(performance guarantee)

330 ×   145 ×   398 mm
(width ×    height ×    depth)

Temperature, humidity

Outside dimensions

Weight

Length of power code

21.5 lb  (9.8kg)

114 inch (2.9m)

+41°F (+5°C) ~ +95°F (+35°C),  30~90%

Legs and lenses are not included.

Replacement parts list
What’s included in the box

1   AC power cable 246C346-10
1   RCA video cable 246C323-10
1 RCA/BNC adaptor 452D173-10
1   Audio cable 242C938-10
1 RGB cable for PC 246C318-10
1 MAC adaptor for RGB cable 246C319-20
1 RS-232C cable 246C320-10
1 MAC adaptor for RS-232C cable 246C321-10

1 Remote control 939P746-10
1   Warranty card 854B311-10
1 User’s manual 871D237-50
1 Software (CD-ROM) 919P095-10
2 Battery for remote –

Accessories
1 Spare metal halide lamp 499B012-10
1 PC audio cable 242D493-10


